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UNIT - I 

Introduction To Computers 

 
A computer is a programmable machine. The two principal characteristics of a computer are: 

 It responds to a specific set of instructions in a well defined manner.

 It can execute a pre recorded list of instructions. Modern computers are electronic and 

digital .

The actual machinery - wires , transistors , and circuits – is called hardware. The instructions 

and Data are called software. 

 CPU - Central Processing Unit – The heart of the computer the component that 

actually executes instructions.

 Memory: - Enables a computer to store at least temporarily data and programs

 Input Device – Usually keyboard or mouse the input device is the conduit through 

which data and instructions enter a computer.

 Output device- A display screen, printer or other such devices that lets you see what 

the computers has accomplished.

Types of Computers 

Personal Computer. 

A personal computer (PC) is a multi-purpose computer whose size, capabilities, and price 

make it feasible for individual use. 

Workstation 

A workstation is a special computer designed for technical or scientific applications 

Minicomputer 

A minicomputer is a type of computer that possesses most of the features and capabilities of a 

large computer but is smaller in physical size. A minicomputer fills the space between the 

mainframe and microcomputer, and is smaller than the former but larger than the latter. 

Supercomputer 

A supercomputer is the fastest computer on earth that could process a considerable number of 

information very quickly. 

 
 

Characteristics of Computer System: Speed 

A computer works with much higher speed and accuracy compared to humans 
whileperforming mathematical calculations. Computers can process millions of 
instructions per second. The time taken by computers for their operations is 
microseconds and nanoseconds. 

https://homepage.cs.uri.edu/faculty/wolfe/book/Readings/Reading01.htm
https://ecomputernotes.com/fundamental/introduction-to-computer/supercomputer
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Accuracy 

Computers perform calculations with 100% accuracy. Errors may occur due to data 

inconsistency or inaccuracy. 

Diligence 

A computer can perform millions of tasks or calculations with the same consistency 

and accuracy. It doesn’t feel any fatigue or lack of concentration. Its memory also makes it 

superior to that of human beings. 

Versatility 

Versatility refers to the capability of a computer to perform different kinds of works 

with same accuracy and efficiency. 

Automation 

Automation is the use of technology to accomplish a task with as little human 

interaction as possible. In computing,  automation  is  usually accomplished  by a program,  

a script, or batch processing. 

Storage 

A computer has built-in memory called primary memory where it stores data. 

Secondary storage are removable devices such as CDs, pen drives, etc., which are also used 

to store data. 

 

WHAT COMPUTER CAN DO 

The computer is a truly amazing machine. Computer plays an important role in our 

daily life. Now a days computer is used to perform different tasks . 

Complex calculations : 

Computer can solve any type of complex calculation and gives us right answer and 

can perform arithmetic and logical operations in a quick way. 

Storage : 

Computer can store large amount of data and information. For Example: Documents 

Pictures Videos etc. 

Entertainment : 

Computer can also be the source of entertainment. We can entertain ourselves by 
playing Games , Watching Movies , Listening Music. 

In offices Computers can be used for preparing letters, documents and reports. 

Computer are can be used for preparing bills and providing enquiry services. In Railways 

computer are can be used to do rail reservation, printing of tickets and preparation of 

reservation charts. 

 

WHAT COMPUTER CAN’T DO 

Productivity: Computers have not yet met all our expectations as a productivity improvement 

tool. 

https://www.computerhope.com/jargon/p/program.htm
https://www.computerhope.com/jargon/s/script.htm
https://www.computerhope.com/jargon/b/batchfil.htm
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Reasoning: Computers can’t think. They can’t discriminate or assimilate widely divergent 

kinds of data, and they have absolutely no capacity for ethical evaluation . 

Errors: Computers don’t make errors , people do easier in the way they program computers 

or in the way they use them. Computers are extremely finicky machines and often 

frustratingly literal. 

 

Five Generation of modern computers: 

First Generation: (1945-1956) 

The first generation computers made use of: 

Vacuum tube technology, 

Punched cards for data input, 

Punched cards and paper tape for output, 

 

The computers of first generation used vacuum tubes as the basic components for 

memory and circuitry for CPU (Central Processing Unit). These tubes, like electric bulbs, 

produced a lot of heat and the installations used to fuse frequently. Therefore,  they were 

very expensive and only large organizations were able to afford it. 

In this generation, mainly batch processing operating system was used. Punch cards, 

paper tape, and magnetic tape was used as input and output devices. The computers in this 

generation used machine code as the programming language. 

Some computers of this generation were 

ENIAC (Electronic Numeric Integrator and Calculator) 

The first all electronic computer was produced by a partnership between the US 

Government and the University of Pennsylvania. It was built using 18,000 vacuum tubes, 

70,000 resistors and 1,500 relays and consumed 160 kilowatts of electrical power. The 

ENIAC computed at speed about thousand times faster than Mark I. However, it could store 

and manipulate only a limited amount of data. Program modifications and detecting errors 

were also difficult EDVAC. 

UNIVAC I 

Remington Rand designed this computer specifically for business data processing 

applications. The Universal Automatic Computer was the first general purpose 

commercially available computer. 

Second Generation : (1956-1963) 

In the second generation computers: 

 Vacuum tube technology was replaced by transistorized technology,

 Size of the computers started reducing,

 Assembly language started being used in place of machine language,

 Concept of stored program emerged,

 High level languages were invented.

The period of second generation was from 195-1963. In this generation, transistors were 

used that were cheaper, consumed less power, more compact in size, more reliable and faster 
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than the first generation machines made of vacuum tubes. In this generation, magnetic cores 

were used as the primary memory and magnetic tape and magnetic disks as secondary 

storage devices. 

In this generation, assembly language and high-level programming languages like 

FORTRAN, COBOL were used. The computers used batch processing and 

multiprogramming operating system. 

The main features of second generation are − 

 

 Use of transistors

 Reliable in comparison to first generation computers

 Smaller size as compared to first generation computers

 Generated less heat as compared to first generation computers

 Consumed less electricity as compared to first generation computers

The Third Generation: (1964-1971) 

 The third generation computers were characterized by:

 Use of Integrated circuits,

 Phenomenal increase in computation speed,

 Substantial reduction in size and power consumption of the machines,

 Use of magnetic tapes and drums for external storage

This generation was characterized by the invention of Integrated Circuits (ICs). The IC 

combined electronic components onto a small chip which was made from quartz. Even more 

components were fitted onto a single chip, called a semiconductor. 

This reduced the size even further. The weight and power consumption of computers 

decreased and the speed increased tremendously. Heavy emphasis was given to the 

development of software. Operating systems were designed which allowed the machine to 

run many different programs at once. A central program monitored and co-ordinate the 

computer s memory. 

Multiprogramming was made possible, whereby the machine could perform several 

jobs at the same time. Computers achieved speeds of executing millions of instructions per 

second. Commercial production became easier and cheaper. Higher level languages like 

Pascal and Report Program Generator (RPG) were introduced and applications oriented 

languages like FORTRAN, COBOL, and PL/1 were developed. 

 

Fourth Generation: (1971-Pesent) 

The general features of the fourth generation computers were: 

 

 Use of Very Large Scale Integration

 Invention of microcomputer

 Introduction of Personal Computers.

Computers of fourth generation used Very Large Scale Integrated (VLSI) circuits. VLSI 

circuits having about 5000 transistors and other circuit elements with their associated  

circuits on a single chip made it possible to have microcomputers of fourth generation. 
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Fourth generation computers became more powerful, compact, reliable, and affordable. 

As a result, it gave rise to Personal Computer (PC) revolution. In this generation, time 

sharing, real time networks, distributed operating system were used. All the high-level 

languages like C, C++, DBASE etc., were used in this generation. 

Fifth Generation: (Present and beyond) 

In the fifth generation, VLSI technology became ULSI (Ultra Large Scale Integration) 
technology, resulting in the production of microprocessor chips having ten million electronic 

components. 

This generation is based on parallel processing hardware and AI (Artificial Intelligence) software. AI 
is an emerging branch in computer science, which interprets the means and method of making 
computers think like human beings. All the high-level languages like C and C++, Java, .Net etc., are 
used in this generation. 

 
 

CLASSIFICATION OF DIGITAL COMPUTER SYSTEM: 

Computers can be generally classified by size and power as follows, 

Personal computer (PCs): 

A small, single-user computer based on a microprocessor. In addition to the 

microprocessor, a personal computer has a keyboard for entering data, a monitor for 

displaying information, and a storage device for saving data. 

Workstation : 

A powerful, single-user computer. A workstation is like a personal computer, but it 

has a more powerful microprocessor and a higher-quality monitor. 

Portable computers: 

A laptop is a small, portable computer and have all the features of a desktop 

computer. The advantage of the laptop is that it is small in size, so it can be  carried 

anywhere. Notebook computers use a variety of techniques, known as flat-panel 

technologies, to produce a lightweight and non-bulky display screen. Laptops Computers are 

costlier than the desktop computers. 

Mini Computers: 

Mini computers are more powerful than the micro computers. They have higher 

memory capacity and more storage capacity with higher speeds. These computers are mainly 

used in process control systems. They are mainly used in applications like payrolls, financial 

accounting, Computer aided design etc. 

Mainframe Computers: 

Main frame computers are very large computers which process data at very high 

speeds of the order of several million instructions per second. They can be linked into a 

network with smaller computers, micro computers and with each other. They are typically 

used in large organizations, government departments . 

Super computer : 

An extremely fast computer that can perform hundreds of millions of instructions per 

second. This type of computer has been developed for scientific applications usually 

involving complex arithmetic and mathematical operations. One such use is in weather 

forecasting. 
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Network computer: 

Network computer are with minimal memory , disk storage and processor power 

designed to connect to a network. This computers designed to connect to the internet are 

sometimes called Internet boxes, Net PCs , and Internet applications. 

 

ANATOMY OF A DIGITAL COMPUTER : 

 

Functions and Components of a Computer: 

To function properly, the computer needs both hardware and software. Hardware 

consists of the mechanical and electronic devices, which we can see and touch. 

The software consists of programs, the operating system and the data that reside in 

the memory and storage device. 

A computer does mainly the following four functions: 

 

1. Receive input – Accept data/information from outside through various input devices like 

the keyboard, mouse. 

2. Process information – Perform arithmetic or logical operations on data/information. 

 

3.Produce output—Communicate information to the outside world through output devices 

like monitor, printer. 

4. Store information—Store the information in storage devices like hard disk, floppy disks. 

These four basic functions are responsible for everything that computers do. The hardware 

components of the computer specialize in any one of these functions. 

Computer hardware falls into two categories: processing hardware and the peripheral 

devices. The Processing hardware consists of the Central Processing Unit (CPU), and as its name 
implies, is where the data processing is done. Peripheral devices allow people to interact with the 

CPU. Together, they make it possible to use the computer for a variety of tasks 

These four basic functions are responsible for everything that computers do. The 

hardware components of the computer specialize in any one of these functions. 

Computer hardware falls into two categories: processing hardware and the peripheral 

devices. The Processing hardware consists of the Central Processing Unit (CPU), and as its name 

implies, is where the data processing is done. Peripheral devices allow people to interact with the 

CPU. Together, they make it possible to use the computer for a variety of tasks. 

Central Processing Unit (CPU) 

 

This part of the computer that executes program instructions is known as the processor or 
Central Processing Unit (CPU). In a microcomputer, the CPU is based on a single electronic 

component, the microprocessor chip, within the system unit or system cabinet. The system unit 

also includes circuit boards, memory chips, ports and other components. A microcomputer’s 

system cabinet. will also house disk drives, hard disks, etc., but these are considered separate 
from the CPU. 
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The CPU has two parts : 

 

1.) The Control Unit (CU). 

 
2.) The Arithmetic Logic Unit (ALU). 

 

Control Unit (CU) – The control unit tells the rest of the computer system how to carry out a 
program’s instructions. It directs the movement of electronic signals between memory – which 

temporarily holds data, instructions and processes information – and the ALU. It  also directs 

these control signals between the CPU and input/output devices. 

Arithmetic/Logic Unit (ALU) – Arithmetic Logic Unit, usually called the ALU, performs two 

types of operations – arithmetical and logical. Arithmetical operations are the fundamental 

mathematical operations consisting of addition, subtraction, multiplication and division. Logical 
operations consist of comparisons. That is two pieces of data are compared to see whether one is 

equal to, less than, or greater than the other. 

 

Memory 

Memory also known as the primary storage or main memory – is  a part of the 
microcomputer that holds data and instructions. Part of the contents of the memory is held only 

temporarily, that is, it is stored only as long as the microcomputer is turned on. When you turn the 

machine off, the contents are lost. The capacity of the memory to hold data and program 
instructions varies in different computers. The original IBM PC could hold approximately several 

thousand characters of data or instructions only. But modern microcomputers can hold millions or 

even billions of characters in their memory. 

Registers 

Computers also have several additional storage locations called registers. These appear in 

the Control Unit and ALU and make processing more efficient. Registers are a sort of special hi- 
speed storage areas that hold data and instructions temporarily during processing. They are parts 

of the Control Unit and ALU rather than the memory. Their contents can, therefore be handled 

much faster than the contents of the memory. 

Addresses 

To locate the characters of data or instructions in the main memory, the computer stores 

them in locations known as addresses. A unique number designates each address. Addresses can 

be compared to post office mailboxes. Their numbers remain the same, but contents continuously 

change. 

 

 

 
MEMORY UNITS: 

Memory units are the internal storage in a computer . The term “memory” identifies data 

storage that comes in this form of chips. There are several different types of memory, 

RAM or Random Access Memory : 

It is the central storage unit in a computer system. It is the place in a computer where 

the operating system, application programs and the data in current use are kept temporarily so 



9 
 

that they can be accessed by the computer’s processor. The more RAM a computer has, the 

more data a computer can manipulate. 

Random access memory, also called the Read/Write memory, is the temporary 

memory of a computer. It is said to be ‘volatile’ since its contents are accessible only as long 

as the computer is on. The contents of RAM are cleared once the computer is turned off. 

ROM or Read Only Memory: is a special type of memory which can only be read and 

contents of which are not lost even when the computer is switched off. It typically contains 

manufacturer’s instructions. Among other things, ROM also stores an initial program called 

the ‘bootstrap loader’ whose function is to start the computer software operating, once the 

power is turned on. 

PROM (Programmable Read Only Memory) 

PROM is read-only memory that can be modified only once by a user. The user buys 

a blank PROM and enters the desired contents using a PROM program. Inside the PROM 

chip, there are small fuses which are burnt open during programming. It can be programmed 

only once and is not erasable 

EPROM (Erasable and Programmable Read Only Memory) 

An EPROM is a special type of PROM that can be erased by exposing it to ultraviolet 

light. It is a programmable read-only memory (programmable ROM) that can be erased and 

re-used. Erasure is caused by shining an intense ultraviolet light through a window that is 

designed into the memory chip. 

EEPROM (Electrically Erasable and Programmable Read Only Memory) 

EEPROM is programmed and erased electrically. It can be erased and reprogrammed 

about ten thousand times. Both erasing and programming take about 4 to 10 ms 

(millisecond). In EEPROM, any location can be selectively erased and programmed. 

EEPROMs can be erased one byte at a time, rather than erasing the entire chip. Hence, the 

process of reprogramming is flexible but slow. 

Flash memory is a non-volatile memory chip used for storage and for transferring data 

between a personal computer (PC) and digital devices. It has the ability to be electronically 

reprogrammed and erased. It is often found in USB flash drives, MP3 players, digital 

cameras and solid-state drives. 

 

INPUT DEVICES: 

Input Devices Input is any data or instructions entered into the memory of a computer. 

An input device is any hardware component that allows a user to enter data and instructions 

into a computer. The following is a list of the most common input devices which are 

nowadays found in a computer system. 

Keyboard: A keyboard contains keys that allow a user to enter data and instructions 

into the computer. All computer keyboards have a typing area that includes the letters of the 

alphabet, numbers, punctuation marks, and other basic keys. Many desktop computer 

keyboards also have a numeric keypad located on the right side of the keyboard. On notebook 

and many handheld computers, the keyboard is built into the top of the system unit. A 

standard computer keyboard is called a QWERTY keyboard because of the layout of its 

typing area which is similar to that of a typewriter. 
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Mouse : A mouse is the most widely used pointing device with a GUI environment  

on personal computers. A mechanical mouse has a rubber ball on its underside to detect 

movement of the mouse. An optical mouse uses devices that emit and sense light to detect the 

mouse's movement. 

A cordless mouse (either mechanical or optical) transmits data using wireless 

technology such as radio waves or infrared light waves. Advantages of using a mouse include 

A mouse is user-friendly for computer beginners. A mouse is easy and convenient to  use 

with a graphical user interface. Using a mouse to select items or move to a particular position 

on the screen is faster than using a keyboard. 

Trackball : A trackball is a stationary pointing device with a ball mechanism on its 

top. Advantages of a trackball include , a trackball is good for limited desk space because the 

user does not have to move the entire device. 

Joystick : A joystick is a pointing device with a vertical lever mounted on a base.  

The lever usually includes buttons called triggers, which activate certain events when  

pressed. Joysticks are mainly used for computer games and ultrasound scanners in hospitals. 

A joystick allows fast interactions required in most games. 

OCR :Most OCR readers include a small optical scanner for reading characters and 

sophisticated OCR software for analysing what is read. 

Written data and printed data can be read at the same time. Hard copies  of  

documents can be read directly into a computer without retyping. The characters converted 

can later be edited by word processing software. 

Scanner : Image Scanner A scanner is a light-sensing input device that converts 

printed text and graphics into a digital form that can be further processed by the computer. 

Two popular types of scanners are: 

A flatbed scanner works like a copy machine except that it creates a file of the 

document rather than a paper copy. 

A handheld scanner can be manually passed over the image to be scanned. A portable 

device you can use to copy an image from paper to your computer. Hand-held scanners are 

ideal for capturing small images, such as signatures and logos. A hand-held scanner is 

smaller, less expensive, and more portable than a flatbed scanner. 

Scanners are mainly used for image processing, which consists of capturing, storing, 

analysing, displaying, printing, and manipulating images. Many scanners also include optical 

character recognition (OCR) software, which can convert an image of text into a text file that 

can be edited. 

OMR : 

Optical mark recognition (OMR) readers can sense hand-drawn marks such as small 

circles or rectangles made on pre-printed forms in certain places. The OMR reader first reads 

the answer key sheet to record the correct answers based on the patterns of light, and then 

reads the remaining documents and matches their patterns of light against the answer key 

sheet. OMR readers are often used for marking multiple choice answer sheets, capturing data 

from questionnaires, enrolment forms, and lottery tickets. 

Advantages of OMR readers include OMR has a better recognition rate than OCR 

because fewer mistakes are made by machines to read marks than by reading handwritten 

characters. Large volumes of data can be collected quickly and easily without the need for  
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specially trained staff. The cost of inputting data and the chance of data input errors could be 

reduced because it is not necessary to type the details for data entry. 

Digital Camera : A digital camera takes pictures and stores the images digitally, 

rather than on traditional film. Digital cameras use different media to store images, which 

include flash memory card, floppy disk and compact disc. 

Advantages of a digital camera include Save money for buying films and developing 

costs in the long term. Images taken can be reviewed. Unwanted images can be deleted 

immediately after the preview. Photographic images can be digitised directly without using a 

scanner. 

Light Pen : A light pen is a pointing device that  can detect the presence of light. 

Light pens are used by health care professionals (such as doctors and dentists) and design 

work. 

Touch screen : A touch screen is an input/output touch-sensitive display. Touch 

screens are often used for information kiosks located in department stores, hotels, airports, 

and museums. Touch screens are also used for ATM machines to allow easy access of bank 

accounts. 

OUTPUT DEVICES: 

One of the most important output devices in computer system is its screen commonly 
called monitor. 

It is an output device and displays all the programs and applications which  are 

running on the computer system. A Monitor is the visual display unit of the computer system. 

It displays images generated from the video output. It displays images without keeping a 

permanent record. A Graphic display is made up of a series of dots called ‘pixels’ (picture 

elements) whose pattern produces images in computer system. 

Each dot on the screen is defined as a separate unit which can be addressed 

separately. Since each dot on the screen can be controlled separately it gives greater 

flexibility in drawing pictures. The Number of dots per inch (dpi) is called the resolution of 

the screen and represents the quality of the computer system. 

In terms of color capabilities, monitors can be divided into the following groups: 

1. Monochrome : These monitors display the result in two colors, i.e., black/white, 

green/black, amber/black. One color is for the background of the screen and other for the 

foreground. 

2. Gray Scale: It is a monochrome type of monitor. But it displays the output by 

using different shades of gray, made by a combination of black and white. 

3. Color Monitor: It can display the output in many colors, ranging from 16 to over 1 

million different colors. These are also called as RGB monitors, because they accept three 

separate signals, which are red, green, and blue. 

Analog Monitor : The Electronic signal that is sent by signals of varying frequency, 

amplitude or phase instead of being sent as an ON or OFF data transmission is called an 

analog signal. Analog signals allow equipment to handle information that continuously 

changes such as voltage, current, etc. 

 Analog signals can be represented by a wave sign and watches which changes 
their position continuously. 
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 These are the traditional type of color monitors and are based on CRT 

technology. These work like the television screen and accept analog signals 

Digital Monitor: An electronic signal that is sent as binary digits of either ON or  

OFF is called a Digital signal. Examples of digital signals and how they look like. In the first 

diagram signals are either 0 or 1 i.e. up or down for ON and OFF mode. In the right digital 

pictures are shown where a pixel is either ON or OFF helping to create an image on the 

display screen. 

The digital monitor receives digital signals and can use CRT technology. The data in 

these monitors is received from the video adapter. These are of different types such as CGA 

(Color Graphics Adapter), EGA (Enhanced Graphics Adapter), VGA (Video Graphics 

Array), and SVGA (Super Video Graphics Array). These are fast and produce clear images. 

Characteristics of a Monitor: 

Classification of monitors on the basis of size : After color classification, the most 

important aspect of a monitor is its screen size. The Size of computer screen is measured in 

diagonal inches and is given by measuring the distance from one corner to the opposite 

corner (diagonally). The smallest size for VGA monitors is 14 inches, which is also the entry 

level monitor for most computer systems. The Larger size landscape monitors can display  

two full pages side by side at a time. Other typical monitor sizes are 17 inches, 20 inches, 23 

inches etc. 

Classification of monitors on the basis of Resolution The resolution of a monitor 

means the number of pixels per inch appearing on its surface. In general the greater the 

number of pixels the sharper is the images. Most modern monitors can display 1024 by 768 

pixels. Some high-end models of computer monitors can display 1280 by 1024, or even 1600 

by 1200 pixels. Even 3280 by 2048 resolution monitors are available for special purposes. 

While CRTs provide variability in resolution LCDs monitor have a fixed resolution.. 

Refresh rate: 

A refresh rate is the number of times your monitor updates with new images each 

second. For example, a 60 Hz refresh rate means the display updates 60 times per second. A 

higher refresh rate results in a smoother picture 

 

Dot pitch . 

Dot pitch is a specification for a computer display, computer printer, image scanner, 

or other pixel-based device that describes the distance, for example, between dots (sub- 

pixels) on a display screen. 

Video Graphics Array (VGA) is a video display controller and accompanying de 

facto graphics standard, first introduced with  the IBM  PS/2 line  of  computers  in 

1987,[1][2][3] which became ubiquitous in the PC industry within three years. The  term can 

now refer either to the computer display standard, the 15-pin D-subminiature VGA 

connector, or the 640×480 resolution characteristic of the VGA hardware. 

SVGA: Short for super VGA , a set of graphics standards designed to offer greater 

resolution than VGA. 

https://en.wikipedia.org/wiki/Video_display_controller
https://en.wikipedia.org/wiki/IBM_PS/2
https://en.wikipedia.org/wiki/Video_Graphics_Array#cite_note-pcmag-1
https://en.wikipedia.org/wiki/Video_Graphics_Array#cite_note-pcmag-1
https://en.wikipedia.org/wiki/Video_Graphics_Array#cite_note-3
https://en.wikipedia.org/wiki/Personal_computer
https://en.wikipedia.org/wiki/Computer_display_standard
https://en.wikipedia.org/wiki/D-subminiature
https://en.wikipedia.org/wiki/D-subminiature
https://en.wikipedia.org/wiki/VGA_connector
https://en.wikipedia.org/wiki/Graphics_display_resolution
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PRINTER : 

Output is data that has been processed into a used form, called information. An output 

device is any hardware component that can display information to a user. The main and most 

common output devices in a computer system are the Printer. 

A printer is an output device that produces text and graphics on a physical medium 

such as paper. Printed information is often called hard copy because the information exists 

physically and is a more permanent form of output than that presented on a VDU (Monitor). 

Printers can be grouped into impact and non-impact printers. 

 An impact printer forms characters and graphics on a piece of paper by 

striking a mechanism against an ink ribbon that physically contacts the paper. 

 A non-impact printer forms characters and graphics on a piece of paper 

without actually striking the paper. 

The printing speed of a printer is usually expressed in pages per minute (ppm). Printer 

resolution is often expressed in dpi (dots per inch). The larger the number, the higher the 

resolution. 

A daisywheel printer : 

A daisywheel printer is an impact printer that uses a wheel as a print head. As the 

wheel rotates, a hammer strikes the backside of the spoke and presses it against the paper to 

print a character. Advantages of a daisywheel printer Can print letter quality characters. 

Disadvantages of a daisywheel printer Printing speed is very slow. Cannot print graphics. 

Dot-Matrix Printer: 

A dot-matrix printer is an impact printer that produces printed images with a print 

head striking mechanism. Most dot-matrix printers use continuous-form paper. A higher 

number of pins on the print head means more dots are printed, which results in higher print 

quality (i.e., a 24-pin printer has better print quality than a 9-pin printer). 

The speed of a dot-matrix printer is normally measured by the number of characters 

per second (cps) it can print. 

Line Printer : 

A line printer is a high-speed impact printer that prints an entire line at a time. The 

speed of a line printer is measured by the number of lines per minute (lpm) it can print. Line 

printers are often used with mainframes, minicomputers, or with a network in applications 

such as manufacturing, distribution, or shipping. 

Ink-Jet printer : 

An ink-jet printer in a non-impact printer that forms characters and graphics by 

spraying tiny drops of liquid ink onto a piece of paper. Ink-jet printers can produce letter- 

quality text and graphics in both black-and-white and colours. Some ink-jet printers can print 

photo-quality images on any type of paper. Printer resolution is measured in dots per inch 

(dpi). The speed of an ink-jet printer is measured in lines per minute (lpm). 

Laser Printer: 

The mechanism of how a laser printer works is similar to a photocopier. Laser printers 

are also known as page printers because they process and store the entire page before they 

actually print it. Most laser printers today can print text and graphics in very high quality y. 
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Plotter : 

A plotter is a large printer that generates high-quality documents by moving ink pens 

over the surface of a page. Plotters are particularly useful to engineers and architects, as they 

produce high-quality blueprints, maps, and floor plans. Two basic types of plotters are pen 

plotters and X-Y plotters. 

Auxiliary storage devices: 

Auxiliary memory holds programs and data for future use, and, because it is nonvolatile 

(like ROM), it is used to store inactive programs… In computer: Secondary memory. 

Secondary memory on a computer is storage for data and programs not in use at the 

moment. 

Magnetic Tape memory: 

  In magnetic tape only one side of the ribbon is used for storing data. It is sequential 
memory which contains thin plastic ribbon to store data and coated by magnetic oxide. Data 

read/write speed is slower because of sequential access. It is highly reliable which requires 

magnetic tape drive writing and reading data. 

Hard Disk: 

Hard disk drive is made up of a series of circular disks called platters arranged one 

over the other almost ½ inches apart around a spindle. Disks are made of non-magnetic 

material like aluminum alloy and coated with 10-20 nm of magnetic material. 

Standard diameter of these disks is 14 inches and they rotate with speeds varying 

from 4200 rpm (rotations per minute) for personal computers to 15000 rpm for servers. Data 

is stored by magnetizing or demagnetizing the magnetic coating. A magnetic reader arm is 

used to read data from and write data to the disks. A typical modern HDD has capacity in 

terabytes (TB). 

CD Drive: 

CD stands for Compact Disk. CDs are circular disks that use optical rays, usually lasers, to read and 
write data. They are very cheap as you can get 700 MB of storage space for less  than a dollar. CDs 
are inserted in CD drives built into CPU cabinet. They are portable as you can eject  the drive,  
remove the CD and carry it with you. There are three types of CDs , 

 CD-ROM (Compact Disk – Read Only Memory) − The data on these CDs are recorded by 

the manufacturer. Proprietary Software, audio or video are released on CD-ROMs. 

 CD-R (Compact Disk – Recordable) − Data can be written by the user once on the CD-R. It 
cannot be deleted or modified later. 

 CD-RW (Compact Disk – Rewritable) − Data can be written and deleted on these optical 

disks again and again. 

Floppy Disk: 

They are flexible plastic discs which can bend, coated with magnetic oxide and are covered 

with a plastic cover to provide protection. Floppy disks are also known as floppies and 

diskettes. 

Jaz Disk: 

A Jaz is a small, portable hard disk drive used primarily for backing up and archiving 

personal computer files. The Jaz drive is sold by Iomega Corporation, the same company 
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that developed the Zip drive. Both the Jaz drive and the disks come in two sizes, 1 GB and 2 

GB 

Super Disk: 

The original Super Disk (shown right) is capable of holding 120 MB on a single disk the 

same size of a traditional 1.44 MB floppy diskette. Later, Super Disks were capable of 

holding 240 MB. 

https://www.computerhope.com/jargon/m/megabyte.htm
https://www.computerhope.com/jargon/f/floppydi.htm
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UNIT –II 

Discovering Office Applications : 

Microsoft Office includes multiple applications; each designed to accomplish a particular 

task. Although each application operates independently of the others, all are designed to tightly 

integrate so information you enter in one application can be shared among the others.  

 

The Office applications covered 

• Word—The Microsoft Office word-processing application. 

 

• Excel—The Microsoft Office spreadsheet application. 

 

. PowerPoint—The Microsoft Office graphics and presentations application. 

 

. Outlook—The Microsoft Office e-mail and personal information management application. 

 
. Access—The Microsoft Office database application 

 

Starting a Program 

Starting a program (also called an application) is simple to do and it’s the first, necessary 

step toward getting anything done. Because computers can be set up differently, you might 

not see the icons on your Desktop 

1. Click on the Start button on the Windows Taskbar. The Start menu will appear. 

2. Click on Programs. The Programs menu will appear. 

3. Click on the Office program name (in this instance, Microsoft Word) that you want 

to start. The Welcome screen for the program will appear briefly before the main program 

window opens. 

If this is the first time you have accessed a Microsoft Office application, the Activation Wizard 

will appear. You can only access Microsoft Office a total of 50 times without using the 

Activation Wizard. After the 50 uses, you will not be able to access Office until you register 

your product with the Activation Wizard. 

 

4. Click on the Activate Later button. The Office application you selected will appear. 
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Identifying Common Screen Elements: 

All Office programs contain common screen elements. 

 

Title bar :A bar displayed at the top of a document that displays the name of the current 

Office program and document. 

Menu bar: A group of all available features in the selected Office program 
Toolbars: A selection of commonly used features. A single click on a toolbar item activates 

the feature. Most Office applications include multiple toolbars 

Window control buttons : Three buttons, Minimize, Maximize/Restore, and Close, used to 

control the size of a document window. 

Mouse pointer :The mouse pointer, which will change shape as it moves to different 

locations on the screen. 

Working area (also called the Document screen) : The white area of the screen where the text 

will appear . 

Insertion point : The blinking vertical line in the document screen that indicates where text 

will appear when you begin typing. 

The insertion point appears in different locations in the various Office programs. On your 

screen, it flashes. The insertion point represents the location at which text will appear when 

you start typing. As you type, the insertion point moves to the right. 

Scroll bars : Horizontal and vertical bars on the bottom and right sides of the screen 

that allow you to see more of a document. 

Task Pane:Small windows that assist you in working with Word. Task panes store collections 

of important features and present them in ways that are much easier to find  and use. There 

are several different task panes. 

Status bar: A bar at the bottom of the screen indicating document information such as the 

current page or the location of the insertion point. 

 

Exiting a Program 

1. Click on the File menu. The File menu will appear. 

2. Click on Exit. The program will close. 
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CHOOSING COMMANDS: 

All Windows programs use menus to select commands and options from, but Office has a 

functionality called personalized menus. When the menu is first accessed, only the most 

common features are displayed. If you pause the mouse pointer over the main menu selection, 

or move it down to the double arrows at the bottom of a menu, the menu will expand to 

include all available features for that menu. 

 

1. Click on Format. The Format menu will appear with eight options. 

2. Pause the mouse pointer over the Format menu. The Format menu will expand to include 

more items. 

3. Move the mouse pointer down a menu to select any item with an arrow. The item will be 

highlighted and a submenu will appear. 

4. Move the mouse pointer to the right of your selection in step 3. 

The first item in the submenu will be highlighted. 

5. Click on a selection in the 

submenu. The feature associated with that menu item will be activated. 
. 

Choosing Commands with the Keyboard: 
You can also open menus and choose commands using the keyboard. 

 

1. Press the Alt key on your keyboard. The menu bar will become active and a box will appear 

around the word “File” on the menu bar. 

2. Press the underlined letter of a menu name. The menu will appear. 
3. Press the underlined letter of a command name. The command will execute. Press the Esc 

key twice to cancel out of the menu. 

Using Shortcut Menus : 
Shortcut menus contain a limited number of commands. The commands you see on a shortcut 

menu depend on what you’re doing at the time you open the shortcut menu. You always click 

the right mouse button (called a right click) to open a shortcut menu. 

1. Move the mouse pointer into the document area. The pointer will appear as an I-beam. 
2. Press the right mouse button (right-click). The mouse pointer will change to an arrow and 

the shortcut menu for regular text will appear in the working area of the document. 

3. Click on a menu selection. The menu action will take place. 

 

Working with Dialog Boxes 

Depending on the dialog box, several types of selections will appear. 
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Tabs 

Tabs look like file folder tabs and let you switch between windows of information. When you 

click on a tab, a window of new information appears. 

 
Command buttons 

Command buttons, such as OK and Cancel, tell the computer to carry out an action. Execute 

an action by clicking on a command button. 

 
Option buttons 

Option buttons appear when you are shown a list of choices (options), and you need to select 

only one option. To select an option, click inside the circle next to your choice. When 

selecting an option, an small black dot fills the circle. 

 
Check boxes 

Check boxes appear when selecting more than one option. To select an option, click inside 

the box. When selecting an option, a check mark appears in the box. 

 
Text boxes 

A text box provides space to type information. For example, when naming a file, you type  

the name into a text box. 
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Drop-down list boxes 

A drop-down list box shows only one option at a time (the option that's selected), and there is 

a downward arrow at the right end of the box. To view the entire list of options, click the 

arrow. Select an option from a list of choices, and click a command button to execute the 

command. 

 
Spin boxes 

A spin box is used to set a value, such as the number of copies to print. To increase or 

decrease the number, click on the up arrow or the down arrow. 

 
List boxes 

A list box usually is a large white space that contains a list of options. If the list of options is 

too long to fit inside the list box, a vertical scroll bar lets you view the entire list. 

 
Sliders 

A slider looks like a sliding volume control on a radio. A slider sets a value within a 

continuous range of values, such as from slow to fast. To move a slider, place the mouse 

pointer on the slider, left-click, and drag it from side to side. 

 

Working with Toolbars : 
 

Separating Toolbars 

Most Office applications include two main toolbars, Standard and Formatting. By default, 

these two toolbars are displayed on the same line and unless you have an extremely large 

monitor screen, you can’t see all the tools. 

1. Open an Office application, for example Word. 

2. Click on Tools. The Tools menu will appear. 
3. Click on Customize. The Customize dialog box will open. 

4. Click on the Options tab. The Options tab will appear in front. 

5. Click on Show Standard and Formatting toolbars on two rows. A check mark will appear 

in the box. 

6. Click on Close. The Customize dialog box will close and both toolbars will appear under 

the menu bar. 
 

Using the Standard Toolbar: 

There are several buttons on the Standard toolbar that are common to most Office 

applications. 

1 New. Delivers a new blank document 
2 Open. Opens a previously created document 

3 Save. Saves a document 

4 E-Mail. E-mails a document. 

5 Print. Prints a document 

6 Print Preview. Shows a document in full page 
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1 Cut. Removes selected information to the Windows Clipboard 

2 Copy. Duplicates selected information to the Windows Clipboard 
3 Paste. Copies information on the Windows Clipboard to the current document 4 Undo. 

Reverses the last action taken 

5 Redo. Reverses the most recent Undo step 

 

Displaying Other Toolbars 
There are a number of other toolbars with buttons appropriate to various tasks. You can display 

as many toolbars as you want, but each additional toolbar you display takes 

room away from your display for seeing your document. 

 

 Click on View. The View menu will appear. 

 Click on Toolbars. The Toolbars submenu will appear. 

 Click on a toolbar. The tool bar will appear. 

 
Some toolbars will appear at the top of your screen, some at the bottom of your screen, or some 

right in the middle of your screen. 

 

1. Press and hold the mouse pointer over the title bar of the toolbar. The mouse pointer 

turns into a four headed arrow. 

2. Press and drag the title bar to a new location. The toolbar will move along with the mouse. 
3. Release the mouse button. The toolbar will remain in the new location. 

 

Closing Toolbars 
If a toolbar is displayed and you no longer need it, you can easily close it. 

 Click on the toolbar close box. The toolbar will close. 

 Click on Toolbars. The Toolbars submenu will appear. Currently displayed toolbars 

have a check mark next to them. 

 Click on the toolbar you want to close. The toolbar will close. 

 

Understanding SmartTags 
 

 SmartTags are new to Office XP. SmartTags are small icons that appear throughout 

your document as you perform various tasks or enter certain types of text.

 SmartTags perform actions in Office applications that would normally require you to 

open other programs.
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 SmartTag functions range from quickly adding a name or address from your 

document to an Outlook contact folder to offering options when pasting data from the 

Clipboard.

 

Finding Common Ways to Work: 

Working with the Task Pane 

A major change to the previous version of Office, Office XP, was the introduction of 

task panes. Office 2003 also uses task panes, which have replaced many of the dialog boxes 

that were a common feature in Office 97 and Office 2000. Office 2003 has also added new 

task panes such as the Research task pane. 

A task pane is a multipurpose window pane that appears on the right side of the 

window of an Office application. 

Changing Task Panes 

 

By default, Office displays the New Document Task pane. The New Document Task pane 

lists common features associated with creating a new document. As you select various 

functions of the application, the Task pane will change automatically. 

 Click on the Task pane drop-down arrow. A list of other Task panes will appear.

 Click on a Task pane name. The selected Task pane will appear.

 

Closing the Task Pane 

 You can close the Task pane during the current session of your current application, 

which will then redisplay the next time you start the program.

1. Click on the Close button. The Task pane will close. 

If you choose a feature that uses the Task pane, the Task pane will reappear. 

 

Redisplaying the Task Pane 

 As previously mentioned, if you choose an Office feature that

used the Task pane, it automatically reappears. You can, however, redisplay the Task pane 

whenever you want it. 

 Click on View. The View menu will appear.

 Click on Task Pane. The Task pane will reopen.
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Adding Random Text: 
 

 To work with this feature, type =RAND() and hit [Enter]. The default is 5 paragraphs 
of 3 sentences each.

 To customize your text,  type =RAND(#  of  paragraphs,  #  of  sentences) and  press 

[Enter]. For example, use =RAND(10,6) for 10 paragraphs with 6 sentences each. 

 

Previewing a Document: 

 
Print Preview allows you to see how your file looks before you print, preventing a waste of 

paper and ink. 

 
To use Print Preview: 

 Open the file you want to preview.

 Choose File

 
 

Printing a Document 

When your document is complete, you’ll probably want to print it. You can send it to 

your printer for a hard copy of the document. 

Printing from the Toolbar 

Each Office program contains a Print button on the standard toolbar that makes printing easy. 
In addition, you can print from Print Preview in both Word and Excel. 

 

1. Click on the Print button. One copy of the entire document will be printed, 
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without showing the Print dialog box 

 

Printing from the Menu 

When electing to print from the menu, a dialog box will appear in which you can determine 

exactly what portion of the document to print, which printer to use, how many copies to print, 

and other printing options. 

 

 Click on File. The File menu will appear.

 Click on Print. The Print dialog box will open.

 Make any desired changes in the Print dialog box. The dialog box will change to 

match your selections.

 Click on OK. The document will be printed.

 

Saving Your Document: 
After you’ve created a document, you need to save it if you intend on using it again. 

Saving a document stores it in a file on your computer’s hard disk, similar to putting a file 

away in a filing cabinet so you can use it later. Once you have saved a document, it’s a good 

idea to save it again from time to time as you work on it. You don’t want to lose all your  

work if the power suddenly goes out or if your computer crashes! In this lesson, you will 

learn how to save an existing document under a different name without changing the original 

document. It’s often easier and more efficient to create a document by modifying one that 

already exists, instead of having to retype a lot of information. 

 

Select File → Save As from the menu. 

The Save As dialog box appears. This is where you can save the document with a new, 

different name. If you only want to save changes you’ve made to a document (instead of 

saving them in a new file), click the Save button on the Standard toolbar, or select 

File → Save from the menu, or press Ctrl+S 

First, you have to specify the drive and/or folder where you want to save your document 

 

Closing a Document : 
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When you are finished working on a file, you should close it. Closing is the equivalent of  

putting it away for later use. When you close a file, you are only putting the document  

away not the program. The application, Word for example, is still  active and ready to work  

for you. 

a. Click on File. The File menu will appear. 

b.. Click on Close. The file will be put away. 

 

Opening an Existing File: 
Opening a file is putting a copy of that file into the computer’s memory and onto your screen 

so that you can work on it. If you make any changes, be sure to save the file again. Office 

provides several ways to open an existing file. 

 

Displaying the Open Dialog Box 

Office applications include an Open dialog box that lists all previously saved files located in 

a particular folder. 

Click on File. The File menu will appear. 

Click on Open. The Open dialog box will appear. 
Click on the file name you want to open. The file name will be highlighted. 

Click on Open. The file will be placed on your screen, ready for you to edit. 

 

Starting a New Document : 

When a Word, Excel, PowerPoint, or FrontPage session first begins, a new empty blank 

document appears ready for you to use. However, during the course of using one of these 

applications you might need to begin another new file. 
 

 Click on the New button. A new screen will appear. 
If you are using Access, a blank screen doesn’t automatically appear. Instead, the  

Task screen appears to assist you in selecting options. 

 
 

Getting Help with Office 

 
Using the Office Assistant 
The Office Assistant is a cute animated character (a paper clip by default) that can answer 

your questions, offer tips, and provide help for all of Word’s features. Many Word users 

don’t use the Office Assistant, but it can be a very helpful tool. If you like using the Office 

Assistant but want a change of pace from Clippit’s antics, you can choose one of eight 

different Office Assistants (see Office Assistants) to guide you through Word. Of course, if 
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you really hate the Office Assistant, you can always shut it off. 

Asking the Assistant for Help 

What sets Office Assistant apart from other help features is that you can use simple, everyday 

language to ask for assistance. 
 

1. Click anywhere on the Office Assistant. A balloon will appear asking, “What would you 

like to do?” with an insertion point flashing in the white text box. 

2. Type a question or just a word or two about what you need assistance with. An example 

might be: “How do I set a tab?” The text will appear in the white text box 3.Click on 

Search. A new window will appear with more choices related to your topic. 

4. Click on a topic. The help information window will appear on your screen. 

5. Click on the help Close box when you are finished reading the help topic. The help 

window will close and the original window will return to full size. 

 

Choosing a Different Assistant 

Is Clippit, the helpful little piece of metal, getting a little dull or just not your style? There is a 

way to select a different icon for Office Assistant 
 

1. Right-click on the Assistant. A shortcut menu will appear. 

2. Click on Choose Assistant. The Office Assistant dialog box will appear with the Gallery tab 

displayed. 

3. Click on Back or Next to view other Assistants. A picture and description of the available 

assistants will appear. 

4. Click on OK when you see the one you want. The Office Assistant dialog box will close and 

you’ll have a new helper. 
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Hiding the Assistant 

 

The Office Assistant is cute, but sometimes it’s just in your way. You can hide the assistant 

and recall it whenever you need it. 

1. Right-click on the Assistant. A shortcut menu will appear. 

2. Click on Hide. The Office Assistant will disappear. 

3. Click on the Help button. The Assistant will reappear. 

 

Turning Off the Assistant 

If you find that you don’t use the Assistant and don’t want to see it, you can turn it off.  
1. Click anywhere on the Office Assistant. The “What would you like to do?” balloon will 

appear. 

2. Click on Options. The Office Assistant dialog box will open. 

3. Click on Use the Office Assistant. The check mark will be removed from the box. 

4. Click on OK. The Office Assistant will be turned off until you manually choose to use it 
again. 

 

Using What’s This? 

There are so many items on an Office application screen, it’s hard to remember what each item 

is or does. You can use the What’s This? feature to identify the various buttons and 

components: 

1. Click on Help. The Help menu will appear. 
2. Click on What’s This? The mouse pointer will change to a black pointer with a question 

mark. 

3. Click the mouse pointer over any button or item on the screen. A detailed information screen 

will appear and explain the item’s function 

4. Click anywhere on the document window. The What’s This? box will close. 

 

Searching the Web for Help 

If you have access to the Internet, Microsoft includes some wonderful assistance from its Web 

site. 

1. Click on the Help command. The Help menu will appear. 

2. Click on Office on the Web. If you are not already connected 
to the Internet, you will be prompted to connect. Your Web browser will launch and a 

Microsoft Office Web page will display. 
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3. Follow the instructions on the screen to access various help topics When you have 

completed accessing the Web help, you’ll want to close the Internet Explorer window. 

4. Click on the Close button. The Internet Explorer window will close. 

You might be prompted to disconnect from your Internet Service Provider (ISP). 
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UNIT- III 

 

Learning Word Basics : 
A flashing vertical bar on your screen when you’re in Word. This is called the 

insertion point. It marks the location where text will appear when you type. If you type a few 

lines of text, you’ll notice that you don’t need to press the Enter key at the end of each line. 

The program automatically moves down or wraps to the next line for you. This feature is 

called word wrap. You only press the Enter key to start a new paragraph. 

 

1. Type some text. The text will display on the screen. 

2. Press Enter. The insertion point will move down to the next line. 

3. Press Enter again. The insertion point will move down another line, creating a blank 

line between your paragraphs. 

4. Type a paragraph of text. Don’t press Enter, just keep typing until you have several 
lines of text. The word wrap feature will take care of moving the insertion point down to the 

next line when necessary. 

5. Continue typing text until your document is complete. The text you type will display on the 

screen. 

 
 

Inserting, Selecting, and Deleting Text 
Inserting Text 

Word begins in insert mode. This means that when you want to add new text to a 

document, simply place the insertion point where you want the new text to be and start 

typing. 

 

1. Click the mouse pointer directly in front of the word within the body of the document 

where you want new text to appear. The blinking insertion point will appear. 

 

2. Type any new word or phrase, adding a space before or after as necessary. The new text is 

inserted into the document. Word will push the existing text to the right and keep moving it over 
or down to make room for the new text. 

 

Selecting Text 

To move, copy, delete, or change the formatting of text, select the text you want to 

edit. When text is selected, it will appear as light type on a dark background on your screen, 

the reverse of non-selected text. In previous versions of Microsoft Word, you could only 

select a sequential block of text at a time, not bits of text in different places. New to Word  

XP is the capability to select non-sequential blocks of text. 
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The following list shows different selection techniques: 

• To select one word, double click on the word. 

• To select a sentence, hold down the Ctrl key and click anywhere on the sentence. 

• To select an entire paragraph, click three times (triple-click) anywhere in the paragraph. 

To select a single line of text, move the mouse pointer to the left margin next to the line. The 

mouse pointer will change to an arrow Click once. 

• To select a block of text, click at the beginning of the text, hold the mouse button down, 

and drag across the balance of the text to be selected. 

• To select non-sequential blocks of text, hold down the Ctrl key and use the previous 

selection techniques for each additional text block you want to include. 

 
 

Deleting Text 

You can delete unwanted text one character, one word, and one paragraph at a time;  

or any combination of these. Two common keys used to delete text are the Backspace and the 

Delete keys. Pressing the Backspace key will delete one character at a time to the left of the 

insertion point, whereas pressing the Delete key will delete one character at a time to the right 

of the insertion point. 

 

1. Select the text to be deleted. The text will be highlighted. 

2. Press the Delete key. The text will be deleted 

 

Using Undo and Redo 

If you want to restore text that you deleted, or reverse an action recently taken, use the Undo 
feature of Word. one click away from reversing your previous action. 

 

1. Click on the Undo button. The last action taken will be reversed. 

If you chose to undo an action and then decided that you liked it better the way you had it, 

choose the Redo feature. 

2. Click on the Redo button. The Undo action will be reversed. Word keeps track of several 

steps that you have recently taken. When you undo a previous step, you’ll also undo any 

actions taken after that step. 
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For example, you changed the case of some text, and then you 

 

bolded and underlined the text. If you choose to undo the Change Case action, the bolding 

and underlining will also be reversed. 

3. Click on the arrow next to the Undo button. A list of the most recent actions will be 

displayed. 

4. Click on the action that you want to undo. The action will be undone as well as all actions 

above it on the list. 

 
Inserting Special Characters or Symbols 

Word includes hundreds of special characters and symbols for you to include in your 

document. Symbols include items like copyright or trademark symbols, stars, check marks, or 

small graphics. 

 

1. Click the mouse where you want the special character to appear. The blinking insertion 

point will appear. 

2. Click on Insert. The Insert menu will appear. 
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3. Click on Symbol. The Symbol dialog box will open. 

4. Click on the down arrow next to the Font list box. A list of fonts will appear. 

5. Click on a font. The symbols available for that font will display. 

6. Click on a character. The character will appear selected. 

7. Click on the Insert button. The symbol or character will be inserted into your document. 

8. Click on the Close button. The symbol dialog box will close. 

 
Moving Around the Screen 

To work with your document, you’ll need to place the insertion point. You can use 

several methods to move around the Word screen, and Word includes a feature called Click 

and Type. 

Using Click and Type 

With Click and Type, you can quickly position the insertion point anywhere on a page 

using the mouse and double-click where you want to enter text. 

 . Double-click the mouse pointer anywhere on the white text area of the screen. A 

blinking insertion point will appear.

 Type some text. The text will appear at the insertion point you clicked.


Using the Scroll Bars 

Two scroll bars are in the document window a vertical scroll bar and a horizontal scroll bar. 

You can scroll through an document by clicking on the scroll bar’s arrows. Scrolling through 

text using the scroll bars does not, however, move the insertion point. You need to click the 

mouse wherever you want the insertion point to be located. 

 

 Click on the arrow at either end of the vertical scroll bar. This will move the  

document up or down in the window. 

A word at a time  Ctrl+Right Arrow or Ctrl+Left Arrow 

A paragraph at a time  Ctrl+Up Arrow or Ctrl+Down Arrow 

A full screen up at a time  The PageUp key 

A full screen down at a time The PageDown key 

To the beginning of a line  The Home key 

To the end of a line  The End key 
To the top of the document  Ctrl+Home 

To the bottom of the document  Ctrl+End 

To a specified page number  Ctrl+G; then enter the page number 

 

Using the Go To Command 

If you have a rather lengthy document, use the Go To command to jump to a specific location 

in the document. 
 

 

1. Click on Edit. The Edit menu will appear. 
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2. Click on Go To. The Go To page of the Find and Replace dialog box will appear. 

3.Type the page number you want to display. The number will appear in the Enter Page 

Number text box. 

4. Click on the Go To button. The specified page will be displayed. The insertion point 

will be located at the beginning of the specified page. 

5. Click on the Close button. The Go To dialog box will close. 

 

Formatting a Word Document 
Enhancing Text 

Enhancing text is the process of changing its appearance. For example, you can 

change fonts or point sizes or add embellishments, such as boldface, italic, or underline. 

Changing the Font 

The font is the typeface of the text. Windows comes with a variety of fonts, and  

Office adds some additional fonts. Other programs installed on your computer might also 

install fonts 

Changing the Font 

. 

 
1. Select some text in the document. The text will be highlighted. 

2. Click on the arrow next to the Font list box. A list of available fonts will appear. 

3. Click on a font name. The font of the selected text will change. 

 
Changing the Font Size 

The font size controls how large the font appears. Each font can be used in a number of sizes. 

Font sizes are measured in points, and a point is 1⁄72 of an inch. 

 

1. Select some text in the document. The text will be highlighted. 

2. Click on the arrow next to the Font Size list box. A list of available font sizes will appear. 

3. Click on a font size. The size of the selected text will change 
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Applying Bold, Italic, or Underline 

Applying formatting attributes such as bold, italic, or underline will call attention to 

particular parts of your text. You can easily access these choices with the Word toolbar. 

 

1. Select the text to be formatted. The text will be highlighted. 
2. Click on the appropriate toolbar button: either B for bold, I for italic, or U for underline, or 

any combination of the three. The formatting will be applied. You can repeat the previous steps 

to remove the attribute. 

 

Copying Formatting to Another Selection 

If you spend several minutes setting up just the right formatting for a heading that will 

appear multiple times in along document, you don’t have to try to remember your selections 

and repeat them each time. Instead, you can use the Format Painter tool. 

 

1. Select any of the text that has the formatting you want to use elsewhere. The text will be 

highlighted. 

2. Click on the Format Painter button. The mouse pointer will change to a paintbrush. 

3. Press and hold the mouse button and drag over the text to be formatted. The new text 

becomes highlighted 

4. Release the mouse button. The new text take on the attributes of the original text 
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Changing Text Case 

When you need to change the capitalization of text, Word provides an easy way to change it 

without retyping.  

1. Select the text to be changed. The text will be highlighted. 

2. Click on Format. The Format menu will appear. 

3. Click on Change Case. The Change Case dialog box will open. 

4. Click on a case option. The option will be selected. 

5. Click on OK. The text will be modified. 

 

Working with Bulleted 

or Numbered Lists 

Everyone uses lists from shopping lists and check lists to meeting agendas and outlines. 

Word can help you format lists in your documents automatically. 
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1. Select the text to be bulleted or numbered. The text will be highlighted. 

2. Click on the Numbering button on the toolbar. The list will have numbers applied to it. 

Arranging Text on a Page 

Justifying Text 

Perhaps the most common way to format a paragraph is to justify it. When you justify text, you 

determine the text's alignment in relation to the right and left margins. Word supports these 

justification options: 
 

 

 Left-justification aligns (makes even) text with the left margin. 

 
 Center-justification centers text between the left and right margins. 

 
 Right-justification aligns text with the right margin. 

 
 Full-justification aligns text with both the left and right margins. 

 
The simplest way to justify existing text is to click anywhere inside the paragraph that you 

want to justify (or select multiple paragraphs if you want to justify several) and then click the 

toolbar's Align Left, Center, Align Right, or Justify (for full justification) buttons. Before you 

start a paragraph, you can click at the left, middle, or right of an empty line of text to justify the 

text that you then type there. 

Changing Line Spacing 

Line spacing is the amount of vertical space between each line of text. You might want 

to change line spacing when you want to make a document easier to read, for example, or for a 

draft so that the reader has room to make changes. 

 

1. Select the text in which you want to change the line spacing. The text will be highlighted. 

2. Click on the Line Spacing button. Line spacing options will appear. You can select  

    from single spacing (1.0), one and one-half line spacing (1.5), or double spacing (2.0). 

3. Click on an option. The new spacing selection is applied to the highlighted text. 
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Indenting Text 

To draw the reader’s attention to certain text, you sometimes want to indent that text so it 

doesn’t line up with the left  margin. Word includes a toolbar button to help you quickly indent 

your text. 

1. Select the text to be indented. The text will be highlighted. 
2. Click on the Increase Indent button. The selected text will move 1⁄2 inch from 

the left margin. 

 

Working with Tabs 

If you press the Tab key to move across the page, you’ll notice that Word has default 

stops set at every 1⁄2 inch. 

Setting Tabs 

You can set tabs at particular points along the ruler so that when you press the Tab key, 

the cursor moves to that point automatically, instead of stopping every five spaces. 

 

Left. The Tab button is already set to the left tab symbol, an “L.” Text will appear with the left 

edge of the text at the tab. 

• Center. Click one time to display the center tab symbol. An upside down “T” will appear. 
Text will center around a center tab. 

• Right. Click two times to display the right tab symbol. A backward “L” will appear. Text will 

appear with the rightedge of the text at the tab. 

• Decimal. Click three times to display the decimal tab symbol. An upside-down “T” with a 

dot on the right will appear. Decimal points, such as dollars and cents, align to the tab. The 

decimal tab is selected in this example 

 

Click on the ruler to set the tab for the current paragraph or any currently selected text. 

A left, right, center, or decimal tab symbol will appear in the ruler at the spot you selected. 

Click in the paragraph and press the Tab key. This moves the insertion point to the tab 

where you want the text to appear. 

Type some text. The text will conform to the chosen tab. This example shows the 

decimal tab alignment. 
 

Moving Tabs 

If you don’t like the position of a tab stop, you can easily move it! 

1. Select the paragraphs that have a tab that needs to be moved. The text will be highlighted. 

2. Drag the current tab setting to the desired location on the ruler bar. A vertical dotted line 

helps you visualize the new tab position. 

3. Release the mouse button. The tab will be reset and any text will be moved. 

 

Deleting Tabs 

Deleting an unwanted tab stop is an easy process when using Words’ ruler. 

1. Select the paragraphs that have a tab that you want to delete. The text will be highlighted. 

2. Drag the current tab setting off the ruler, into the body of the document. As you are 
dragging across the ruler, a vertical dotted line will appear. 3. Release the mouse button. 

The tab will be deleted. 
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Moving or Copying Text 
Windows includes a feature called the Clipboard, which lets you hold information temporarily. 

Microsoft Word, as well as the other Office applications, uses the Clipboard feature to move or 

copy text from one place to another. 

 

Moving Text 

The feature used to move text from one place to another is called cut and paste. With cut and 

paste, the original text is deleted and placed in the new location. 

1. Select the text to be moved. The text will be highlighted. 
2. Click on the Cut button. The text will be removed from the document, and will be stored  on 

the Windows Clipboard. 

3. Click the mouse where you want the text to be located. The blinking insertion point will 

appear. 

4. Click on the Paste button. The text will be placed at the new location. 
 

Copying Text 

The process of copying text will leave the text in its original location while a copy of it is 

placed on the Windows Clipboard. 

1. Select the text to be copied. The text will be highlighted. 
2. Click on the Copy button. The text will be stored on the Windows Clipboard. It doesn’t 

appear that anything happened, but it did. 

3. Click the mouse where you want the text to be located. The blinking insertion point will 

appear. 

4. Click on the Paste button. 

 

Using Drag-and-Drop 

Another method of moving text from one location to another is to use the drag-and-drop 

method. The drag-and-drop method works best when you’re moving a small amount of text a 

short distance: 

1. Select the text to be moved. The text will be highlighted. 

2. Position the mouse pointer on top of the highlighted text. The white mouse arrow will point 

to the left. 

3. Hold down the mouse button and drag the mouse to the desired location. A small box will 

appear at the bottom of the mouse arrowhead and a gray line will indicate the position of the 

text. 

4. Release the mouse button. The text will be moved. 

 

Improving Your Writing 
Working with AutoCorrect and AutoFormat 

AutoCorrect is a great feature. If you type something wrong, Word automatically corrects it. 

Or, if you type “(c)” and Word interprets it as a copyright symbol, it will insert 

Adding AutoCorrect Entries 

If you know that you commonly make the same typing mistake, such as typing “click” when it 
should be “click,” you can instruct Word to fix it for you. 

1. Click on Tools. The Tools menu will appear. 

2. Click on AutoCorrect Options. The AutoCorrect dialog box will open with the autoCorrect 

tab in front. 

3. Type your common mistake in the Replace text box. The text will display. 
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4. Click in the With text box.A blinking insertion point will display. 

5. Type the correct word spelling. The text will display. 

 
 

6. Click on Add. The word will be added to your permanent AutoCorrect list. 

7. Click on OK. The dialog box will close. 

 

Deleting AutoCorrect Entries 

What if you’re typing an article about common misspellings and you want to type the word 

“teh” or you want to use “(c)”to indicate a heading in a report, but Word keeps changing  them 

1. Click on Tools. The Tools menu will appear. 

2. Click on AutoCorrect Options. The AutoCorrect dialog box will appear with the 

AutoCorrect tab in front. 

3. Click on an entry from the AutoCorrect list. The entry will appear in the Replace and  With 

text boxes. 

4. Click on Delete. The entry will be deleted. 
5. Click on OK. The AutoCorrect dialog 

. 

. 

 

 

 

 



40 
 

Find and Replace 
Word 2003 allows you to search for specific words in your document, as well as  fonts, 

special characters, and formats. The Find and Replace functionality can really help save 

you time and effort in your word processing goals. 

 
For example, let's say that a document you are editing that displays Word XP needs to be 

updated to Word 2003. Currently, the document has the text "Word XP" typed in various 

spots throughout the document. Using Find and Replace to replace Word XP with Word 2003 

will save you time and effort in your editing process. 

 
To use the Find feature: 

 Click Edit on the menu bar.

 Select Find. The Find and Replace dialog box appears.

 Type a word, phrase, or format in the Find What box.

 Click Find Next to start the search.

 Word will jump to the first instance of this word and highlight it.

 Continue clicking the Find Next button to find all other instances of the 
word.

 
Check the Highlight all items found in: box to find all instances of the word at the same 

time. Use the list box below to select all or portions of your document. 

 

 
You can perform a more detailed search by clicking the More button on the Find and Replace 

dialog box. 

 
To use Find and Replace: 

 Click Edit on the menu bar.

 Select Find. The Find and Replace dialog box appears.
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 Type a word, phrase, or format in the Find What box.

 Click More to conduct a detailed search.

 Click the Search list box if you want to limit your search to a specific part of 

the document.

 Use the check boxes to limit your search.

 Click Format if you want to limit your search to words in a specific font, 

paragraph, tab, language, frame, style, or highlight.

 Click Special to search for punctuation marks or section breaks.

 Click Find Next to start the search.

 

To use the Replace feature: 

 Click Edit on the menu bar.

 Select Replace. The Find and Replace dialog box appears.

 Type the word, phrase, or format in the Find What: box that you are searching for.

 Type the word, phrase, or format in the Replace With: box that will replace what is in 

the Find What: box.

 Click Find Next to conduct your search.

 When Word finds a word of phrase, do one of the following:

o Ignore it. 

o Click Replace. 

o Click Replace All to replace every occurrence of the selected text with the 
replacement text. 

 Click Find Next to bypass it and find the next.

 Click Cancel to quit.

Correcting Spelling and Grammatical Errors 

 
Checking Spelling as You Go 

By default, Word identifies problems right in your document as you type. Spelling errors 

have a red wavy line underneath them, whereas grammatical errors are indicated with a green 

wavy line. 

1. Right-click on the questionable word. The shortcut menu will appear with suggested 

corrections. 

2. Click on the correct spelling or grammatical suggestion. The erroneous word will be 

replaced with your selection 
 

Running a Spelling and Grammar Check 

By default, Word can run both a spelling and grammar check at the same time. 
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1. Click on Tools. The Tools menu will appear. 

2. Click on Spelling and Grammar. The Spelling and Grammar dialog box will open. 
The first error encountered, whether spelling or grammar, will be displayed. If it’s a 

spelling error, it is identified in the Not in Dictionary text box. In the Suggestions text box, 

there are possible correct spellings for the word. 

 

Click on the correct spelling if available. The replacement will be highlighted. Click on one of 
the following options: 

• Change. Changes only this incident of the spelling mistake. 

• Change All. Use this if you think you made the mistake more than once. 

• Ignore Once. If you don’t want to correct this instance of the spelling, use this option. 

 

Finding That Elusive Word with the Thesaurus 

  Click on the word that you want to replace with a better one. The insertion point will 

appear in the word.

 Click on Tools. The Tools menu will appear.

 

 Click on Language. A submenu will appear.

 Click on Thesaurus. The Thesaurus dialog box will open. Many words have multiple 

meanings. Word frequently lists many of the possible meanings of your word.

 Click on a meaning. A selection of synonyms will appear on the right.

  Click on a word in the Replace with Synonym text box that fits your document better 

than the original. The word will be highlighted.

Click on Replace. The word will be replaced with the suggestion. 
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Working with Longer Documents: 
Setting Page Options 
Page options that you can modify include the margins, the orientation and the size of the 

paper. 

Changing Margins and Orientation 

To access the Page Layout ribbon, press Alt + P. To set the margins: In the Page Layout 

ribbon, tab to Margins button and press Enter (or alternatively press M). Arrow down to 

choose a preset margins that you want, such as Narrow Margins and press Enter. 
 

 

 Margins encompass the amount of space between the edges of the paper and where the 

text actually begins to appear.

 

1. Click on File. The File menu will appear. 

2. Click on Page Setup. The Page Setup dialog box will open. 

3. If necessary, click on the Margins tab. The Margins tab will be displayed. 

4. Click on the up or down arrows to the right of the Top, Bottom, Left, and Right list boxes to 

increase or decrease the top, bottom, left, or right margin settings, respectively. 

5. Click on Landscape. The option will be selected and the document will print along the long 

edge of the paper. 
 

Selecting a Paper Size: 
Word supports any printer supported by Windows. This is because Word uses the features 

offered by Windows to print documents. Many of the features associated with formatting 

your document and printing are related to the type of printer you have installed and selected. 

For instance, many printers will support different sizes of paper. If your printer does this, and 

you want to change the paper size used for your document, you should follow these steps: 
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1. Choose the Page Setup option from the File menu. You will see the Page Setup dialog 

box. 

2. Select the Paper Size or Paper tab. 
 

 

 

 

Managing Page Breaks 
Word automatically inserts a page break when text fills the page. If you want the page 

break to be in a different place, you can override the automatic page break by creating your 

own. 

 

Inserting a Page Break 

You can break the page at a shorter position than Word chooses, but you cannot make a page 

longer. 

*.Click the mouse in front of the text where you want the new page to begin. The blinking 

insertion point will appear. 

*.Click on Insert. The Insert menu will appear. Click on Break. The Break dialog box will 

open Click on Page break. The option will be selected. Click on OK. The page break will be 

inserted. 
 

Deleting a Page Break 

1. Go to Home and select Show/Hide . This displays page breaks while you're working on your 

document. 

2. Double-click the page break to select it and then press Delete. 
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Working with Headers and Footers 

 
The header and footer usually contain title and author information, dates, and page numbers. 

The header appears at the top of the page, while the footer appears at the bottom of the page. 

 
To insert a header and footer: 

 Click View on the menu bar.

 Select Header and Footer.

 The document will appear grayed out with a dotted Header and Footer box 

showing at the top and bottom of the page.

 Locate the Header and Footer toolbar on the page.
 

 Type inside the dotted boxes to insert your header and/or footer.

 Click Close on the Header and Footer toolbar when you're finished.

 

 
AND 

 

 
The Header and Footer toolbar 

 
The Header and Footer toolbar contains buttons that can help you automatically enter 

important information in your header and footers. 

 
Some of the useful features located on the Header and Footer Toolbar are: 

 Insert Auto-Text: This drop-down menu shows commonly used header and 

footer information, including, author, page number, and date.

 Insert Page Numbers: This feature inserts page numbers.
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 Insert Number of Pages: This inserts the number of pages in the entire 

document.

 Format Page Number: This opens the Page Number Format dialog box so 

you can format your page number in the header and footer.

 Insert Date.

 Insert Time.

 Page Setup: This opens the Page Setup dialog box so you can adjust the 

location of the header and footer.

 Switch between Header and Footer: This allows you to jump quickly 

between the header and footer on a page.

 Close: This closes the Header and Footer toolbar.
 

 

 

 
 

 

 
 

Deleting headers and footers 

 
If you choose to delete your header or footer, Word will automatically delete the header or 

footer within the entire document. 

 
To delete the header or footer: 

 Click View on the menu bar.

 Select Header and Footer.

 Highlight the text within the header or footer (whichever text you would like 

to delete).

 Press Delete. The text is now removed.

 Click Close.

You can delete the header and footer on just the first page of the document by choosing 

File and then Page Setup. In the Page Setup dialog box, choose the Layout Tab and place a 

check mark next to Different First Page under Headers and Footers, then click OK. 

 



47 
 

Displaying Non-Printing Characters 

 
To assist you in editing a document, Word can display some hidden symbols it uses to 

indicate spaces, tabs, and hard returns. These symbols do not print, but can be displayed on 

your screen for your convenience. 

 

 

Click the Show/Hide ¶ button. The hidden characters will be displayed 

Click the Show/Hide ¶ button. The displayed special characters will be hidden again. 
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UNIT-IV 

MS-EXCEL 

 
Creating a Simple Spreadsheet: 
Exploring the Spreadsheet Screen 

The Excel window 

Many items you see on the Excel 2003 screen are standard in almost all other Microsoft 

software programs, including Word, PowerPoint, and previous versions of Excel. Some 

elements are specific to this version of Excel. 

 

 

 

 
Workbook 

 
Also called a spreadsheet, the workbook is a unique file created by Excel. 
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Title bar 
 

 
The Title bar displays both the name of the application and the name of the spreadsheet.  

 

Menu bar 

 

 
The Menu bar displays all of the menus that are available for use in Excel 2003. The contents 

of any menu can be displayed by clicking on the menu name with the left mouse button. 

 
Toolbar 

 
Some commands in the menus have pictures or icons associated with them. These pictures may 

also appear as shortcuts in the toolbar. 

 

 
 

Column headings 
 
 

 
Each Excel spreadsheet contains 256 columns. Each column is named by a letter or 

combination of letters. 

 
Row headings 
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Each spreadsheet contains 65,536 rows. Each row is named by a number. 

 

Name Box 
 
 

 
This shows the address of the current selection or active cell. 

 

Formula bar 

 

 
The Formula bar displays information entered—or being entered as you type—in the current or 

active cell. The contents of a cell can also be edited in the Formula bar. 

 
Cell 

 

 
A cell is an intersection of a column and row. Each cell has a unique cell address. In the 

picture above, the cell address of the selected cell is B3. The heavy border around  the 

selected cell is called the cell pointer. 

 
Navigation buttons and sheet tabs 

 
 

 
Navigation buttons allow you to move to another worksheet in an Excel workbook. They are 

used to display the first, previous, next, or last worksheets in a workbook. 
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Sheet tabs separate a workbook into specific worksheets. A workbook defaults to three 

worksheets. Each workbook must contain at least one worksheet. 

 
Workbooks and worksheets 

 
A workbook automatically shows in the workspace when you open Microsoft Excel 2003. 

Each workbook contains three worksheets. A worksheet is a grid of cells consisting  of 

65,536 rows by 256 columns. Spreadsheet information—text, numbers, or mathematical 

formulas—is entered in the different cells. 

 

 
Column headings are referenced by alphabetic characters in the gray boxes that run across the 

Excel screen, beginning with Column A and ending with Column IV. 

 
Rows are referenced by numbers that appear on the left and then run down the Excel screen. 

The first row is named Row 1, and the last row is named 65536. 

 
Important terms 

 
 A workbook is made up of three worksheets. 

 The worksheets are labeled Sheet1, Sheet2, and Sheet3. 

 Each Excel worksheet is made up of columns and rows. 

 In order to access a worksheet, click on the tab that says Sheet#. 

 
The cell 

 
An Excel worksheet is made up of columns and rows. Where these columns and rows 

intersect, they form little boxes called cells. The active cell, or the cell that can be acted upon, 

reveals a dark border. All other cells reveal a light gray border. Each cell has a name. Its  

name is comprised of two parts: the column letter and the row number. 
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In the picture below, cell C3—formed by the intersection of column C and row 3—contains a 

dark border. It is the active cell. 

 

 
Important terms 

 
 Each cell has a unique cell address, which is composed of a cell's column and row. 

 The active cell is the cell that receives the data or command you give it. 

 A darkened border, called the cell pointer, identifies it. 

 
Moving around the worksheet 

 
You can move around the spreadsheet in several different ways. 

 

To move the cell pointer: 

 To activate any cell, point to a cell with the mouse and click. 

 To move the pointer one cell to the left, right, up, or down,  use  the keyboard arrow 

keys. 
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To scroll through the worksheet: 

 
The vertical scroll bar located along the right edge of the screen is used to move up or down 

the spreadsheet. The horizontal scroll bar located at the bottom of the screen is used to 

move left or right across the spreadsheet. 

 

 
The PageUp and PageDown keys on the keyboard are used to move the cursor up or down 

one screen at a time. Other keys that move the active cell are Home, which moves to the first 

column on the current row; and Ctrl+Home, which moves the cursor to the top-left corner of 

the spreadsheet, or cell A1. 

 
To move between worksheets 

 
As mentioned, each workbook defaults to three worksheets. These worksheets are 

represented by tabs—named Sheet1, Sheet2, and Sheet3—that appear at the bottom of the 

Excel window. 

 
To move from one worksheet to another worksheet: 

 Simply click the sheet tab (Sheet1, Sheet2, or Sheet 3) that you want to 

display. 
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Entering Data 
Spreadsheet data is made up of three components: labels, values, and formulas. 

 

Entering Labels 

Labels are traditionally descriptive pieces of information, such as names, months, or 

types of products. Excel identifies a cell as a label if it begins with a letter or contains any 

letters. 

 

Labels are traditionally descriptive pieces of information, such as names, months, or 

types of products. Excel identifies a cell as a label if it begins with a letter or contains any 

letters. 

 
Click on the cell where you want to place the label. A border will appear around the 

selected cell. Type some text. A blinking insertion point will appear . 

Press the Enter key to accept the label. The text will be entered and will align along 

the left edge of the cell. The cell below the one where you just entered data will then be 

selected. 

Entering Values 

Values are the raw numbers that you track in a spreadsheet. There is no need to enter 

commas or dollar signs. 

 

Editing Data 

You can edit your data in a variety of ways. You might need to change the contents of a cell, 

or you might want to move the data to another part of the spreadsheet. 

 

Editing the Contents of a Cell 

The other way to make changes to the contents of a cell is by using the Edit feature. 

 

 Double-click on the cell to be edited. The insertion point will blink within the cell.

 Press the left arrow key. The insertion point will be relocated within the current cell.

 Type the changes. The changes will appear in the current cell.

 Press the Enter key. The changes will be entered into the current cell.

 

Editing a Spreadsheet : 
Learning Selection Techniques 

To move, copy, delete, or change the formatting of data in the spreadsheet, the cells to 

be modified must first be selected. When cells are selected, they appear darker on screen just 

the reverse of unselected text. However, if a block of cells is selected, the first cell will not 

have the darker shading around it. 

 

The following table describes some of the different selection techniques. 

1 A cell Click on the desired cell. 

2 A row Click on the row number on the left side of the screen. 

3 A column Click on the column letter at the top of the screen. 

4 A sequential Click on the first cell and drag to highlight the rest of the cells. 

block of cells 

5 A non sequential Click on the first cell, then hold down the 

block of cells  Ctrl key and click on any additional cells. 
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Inserting Rows and Columns : 

 
Inserting a row: 

 
You can insert a row in a spreadsheet anywhere you need it. Excel moves the existing rows 

down to make room for the new one. 

 
To insert a row: 

 Click anywhere in the row below where you want to insert the new row.

 Choose Insert Rows from the menu bar.
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 A new row is inserted above the cell(s) you originally selected.

 Click anywhere in the row below where you want to insert the new row.

 Right-click and choose Insert from the shortcut menu.
 

 The Insert dialog box opens.
 

 

 

 

 Choose the Entire Row button.

 Click the OK button.

 A new row is inserted above the cell(s) you originally selected.
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Select multiple rows before choosing Insert to add rows quickly. Excel inserts the same 

number of new rows that you originally selected. 

 
Inserting a column : 

 
In Excel, you can insert a column anywhere you need it. Excel moves the existing columns to 

make room for the new one. 

 
To insert a column: 

 Click anywhere in the column where you want to insert a new column.

 Choose Insert Columns from the menu bar.
 

 A new column is inserted to the left of the existing column.

 Click anywhere in the column where you want to insert a new column.

 Right-click and choose Insert from the shortcut menu.
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 The Insert dialog box opens.
 

 Click the Entire Column button in the Insert dialog box.

 Click the OK button.

 A new column is inserted to the left of the existing column.
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You can also select multiple columns before choosing Insert to add columns quickly. 

Excel inserts the same number of new columns that you originally selected. Deleting columns 

and rows 

Columns and rows are deleted in much the same manner as inserting columns and rows. 

 

To delete a row and all information in it: 

 Select a cell in the row to be deleted.

 Choose Edit Delete from the menu bar.

 Click the Entire Row button in the Delete dialog box.
 

 Click the OK button.

 

To delete a column and all information in it: 

 Select a cell in the column to be deleted.

 Choose Edit Delete from the menu bar.

 Click the Entire Column button in the Delete dialog box.
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 Click the OK button.

Moving Data Around 
If you’re not happy with the placement of data, you don’t have to delete it and retype it. Excel 

makes it easy for you to move it around. 

 

Copying and Pasting Cells 

The Windows Clipboard is extremely helpful if you want to transfer 

information from one place to another. To copy information, Excel uses the Copy and 

Paste features. 

 

 Select some cells to be duplicated. The cells will be highlighted.

 Click on the Copy button. “Marching ants” will appear around the copied cells.

 Click on the beginning cell where you want to place the duplicated information. The 

cell will be highlighted.

 Press the Enter key. The information will be copied to the new location.

 

Using Drag-and-Drop to Move Cells : 

Move information from one location to another is the drag-and-drop method. 

 Select some cells to move. The cells will be highlighted.

 Position the mouse pointer around one of the outside edges of the selection. The 

mouse pointer will become a small white arrow with a black cross in front of it.

 Keeping the mouse pointed around the outside edge, press and hold the mouse button 

and drag the cells to a new location.

Release the mouse button. The cells will be moved. 

 
Clearing Cell Contents : 

If you have data in cells that you no longer want, you can easily delete the data. 

1. Select some cells to be cleared. The cells will be highlighted. 

2. Press the Delete key. The contents of the cells will be removed. 
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Using the Fill Feature: 

 

Excel has a great built-in, time-saving feature called Fill. If you give Excel the 

beginning Month, Day, or numbers, it can fill in the rest of the pattern for you. For example, 

if you type January, Excel fills in February, March, April, and so on. 

 Type the beginning Month, Day, or Number in the beginning cell. The text will be 

displayed in the cell.

  Position the mouse pointer on the lower-right corner of the beginning cell. The mouse 

pointer will become a small black cross.

 Press and hold the mouse button and drag to select the next cells to be filled in. The  

cells will have a gray border surrounding them. Release the mouse button. The pattern 

will be repeated.

 

Working with Functions and Formulas : 
Creating Formulas 

All formulas must begin with the equals (=) sign, regardless of whether the formula consists 

of adding, subtracting, multiplying, or dividing. 

 

Creating a Simple Formula 

An example of a simple formula is =B5+B6, which adds the contents of cells B5 and B6. 

 Click on the cell in which you want to place the formula’s result. The cell will be 

selected.

Type an equals sign (=) to begin the formula. The symbol will display in the cell.  

 Type the cell address of the first cell to be included in the formula. This is called the cell 

reference.

 Type the operator: plus (+), minus (–), multiply (*), or divide ( / ). The operator will 

display in the formula.

 Type the reference to the second cell of the formula. The reference will display in the 
cell.

 Excel references the second cell address in a different color and places a matching color 

box around the referenced address.

 Press the Enter key. The result of the calculation will appear in the cell.

Creating a Compound Formula 

You use compound formulas when you need more than one operator. Examples of a 
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compound formula include =B7+B8+B9+B10 or =B11–B19*A23. 

 
 

o Click on the cell in which you want to place the formula’s result. The cell will 
be selected. 

o Type an equals sign (=) to begin the formula. The symbol will display in the 
cell. 

o Type the reference to the first cell of the formula. The reference will display in 
the cell. 

o Type the operator. The operator will display in the cell. 
o Type the reference to the second cell of the formula. The reference will 

display in the cell. 

o Type the next operator. The operator will display in the cell. 
o Type the reference to the third cell of the formula. The reference will display 

in the cell. 

Press the Enter key to accept the formula. The answer will be displayed in the 

cell and the formula will be displayed in the content bar. 

Editing Entries 

Excel provides several methods of editing an incorrect cell, whether it’s a label, a 

value, or a formula. One method involves simply retyping the desired data in the correct cell. 

When you press Enter, the new data replaces the old data. If however, the data is complex or 

lengthy, you might want to edit only a portion of the existing information. 

Editing from the Cell 

o You can make changes to a cell entry directly in the cell. Double-click on the cell you 
want to modify. The blinking insertion point will appear in the cell. When editing formulas, 
Excel color codes each cell address to its corresponding cell. 
o Type any corrections. You may need to use the keyboard arrow keys to move the 
insertion point to the position of the incorrect data. The correction will appear in the cell and 
on the Formula line. 

o Press the Enter key. The correction will be accepted and if the data was a formula, the 
answer will be recalculated. 

 

Copying Formulas 

Now that you’ve created a formula, there’s no reason to type it over and over for 

subsequent cells. Let Excel copy the formula for you! 

Copying Using the Fill Feature 

 Click on the cell that has the formula. The cell will be selected. 
 Position the mouse pointer on the lower-right corner of the beginning cell. The 

mouse pointer will become a black cross. 

 



63 
 

 Press and hold the mouse button and drag to select the next cells (up, down, left, or 

right)  to  be  filled  in.  The  cells  will be selected. Release the mouse button. The 

formula will be copied. 

Copying with Copy and Paste 

If the cells are not sequential, you can use Copy and Paste. 
1. Select the cell containing the formula that you want to duplicate. The cell will be selected. 

2. Click on the Copy button. Marching ants will appear around the copied cells. 
3. Highlight the cells in which you want to place the duplicated formula. The cells will be 

selected. 

4. Press the Enter key. The formula will be copied to the new location. 

Using Functions: 

 

Sometimes, formulas can be quite complex and time consuming to build. Excel has hundreds 

of different functions to assist you with your calculations. All Excel built-in functions begin 

with the equals (=) sign and have the basis (arguments) for the formula in parentheses. 

 

Using the SUM Function 

The SUM function totals a range of values. The syntax for this function is =SUM(range of 

values to total). An example is =SUM(B8:D8). 

 
o Click on the cell in which you want to place the sum of values. The cell will  be 

selected. 

o Type the equals (=) sign. The symbol will display in the cell. 
o Type the function name SUM. The characters will display in the cell. Function 

names are not case sensitive, therefore typing “SUM” is the same as typing 
“sum”. 

o Type the open parenthesis symbol. The symbol will display in the cell. 

o Type the range to be totaled. The range will display in the cell. 

o Type the close parenthesis symbol. The symbol will display in the cell. 

Press the Enter key. The total of the range will be displayed in the selected cell. 

Using the AutoSum Button 

Excel includes the SUM function as a button on the toolbar. This makes creating a simple 

addition formula a mouse click away 

1. Click on the cell below or to the right of the values to be totaled. The cell will be selected. 

2. Click on the AutoSum button. The cells to be to talled are highlighted. 
3.Press the Enter key. Excel will enter the sum of the values above it or to the left of it. 

 

Using the AVERAGE Function 

The AVERAGE function finds an average of a range of values. 

The syntax for this function is =AVERAGE(range of values to average). An example is 

=AVERAGE(B7:D7), which would calculate an average of the values in cells B7 through D7. 

1. Click on the cell in which you want to place the average. The cell will be selected. 

2. Type the equals (=) sign. The symbol will display in the cell. 

3. Type the function name AVERAGE. The characters will display in the cell. 

4. Type the open parenthesis symbol. The symbol will display in the cell. 
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5. Type or highlight the range to be averaged. The range will display in the cell. 

 

6. Press the Enter key. Excel will place the closing parenthesis and average the values in the 

selected range. 

Other similar functions are MAX,MIN, and COUNT 

• MAX function. Finds the largest value in a range of cells. Example: =MAX(B8:D8). 

• MIN function. Finds the smallest value in a range of cells. Example: =MIN(B8:D8). 

• COUNT function. Counts the number of non-blank cells in a range of cells. Example: 

=COUNT(B8:D8). 

 

Formatting Worksheets : 
Formatting Numbers: 

By default, values are displayed as general numbers. Values can be displayed as currency, 

percentages, fractions, dates, and many other formats. 

 

Formatting Numbers with the Toolbar : 

Three popular number styles are accounting, commas, and percentages. Accounting and 

comma formats automatically apply two decimal points, whereas the percentage format doesn’t 

apply any decimal points. The accounting style also applies a dollar sign to the number. Excel 

includes buttons on the toolbar for these formats. 

 

1. Select some cells to be formatted. The cells will be highlighted. 

2. Click on the Currency button. The cells will be formatted with a dollar sign and two decimal 

places. 

Changing the Decimal Point Places 

The number of decimal places assigned to a style might not be exactly what you want. Excel 

includes two buttons on the toolbar to give you control over the number of decimal places. 

Each cell can have from 0 to 15 decimal places. 

 

1. Select the cells you want to change the decimal place in. The cells will be highlighted. 

2. Click on the Increase decimal button. An additional decimal place will be assigned. 

 

Adjusting Column Widths 
The default width of a column is 8.43 characters, but each column can be from 1 to 240 

characters wide. 

A line located at the right edge of each column heading divides the columns. You will use this 

line to change the column width. 
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1. Position the mouse pointer on the right column line for the column that you want to change. 

The mouse pointer will become a black, double-headed arrow. 
 

2. Press and hold the mouse button and drag the column line. If you drag it to the right, the 

column width will increase; if you drag it to the left, the column width will decrease 

3. Release the mouse button. The column width will be changed. 

 

Setting Cell Alignment 
Labels are left aligned and values are right aligned by default; however, you can change the 

alignment of either one to be left, right, centered, or full justified. Also by default, both are 

vertically aligned to the bottom of the cell. 

Wrapping text in cells is useful when text is too long to fit in one cell and you don’t want it to 

overlap to the next cell. Adjusting Cell Alignment You can adjust cells individually or adjust  

a block of cells. 

 
 Select the cells to be formatted. The cells will be highlighted.

 Click on Format. The Format menu will appear.

 Click on Cells. The Format Cells dialog box will open.

 If necessary, click on the Alignment tab. The Alignment tab will come to the front.

 Click on an option under the Horizontal list box. The horizontal alignment of the text in 

the cell will change.

 Click on an option under the Vertical list box. The vertical alignment of the text  in the 

cell will change.

 Click in a desired check box under Text control to make the option active. A check mark 

will appear in the selection box.
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Click on OK. The selections will be applied to the highlighted cells. 
 

Centering Headings 

Text also can be centered across a group of columns to create attractive headings. 

1. Type the heading text in the first column of the worksheet body. This is usually column A. 

2. Select the heading cell and the cells to be included in the heading. The cells will be 

highlighted. 

3. Click on the Merge and Center button. The title will be centered. 

Formatting with Fonts 

 

The default font in a spreadsheet is Arial 10 points, but you can easily change both the 

typeface and size. 

 

Selecting a Font Typeface 

Your font choices will vary depending on the software installed on your computer. 

 
 

1. Select some cells to change the typeface. The cells will be highlighted. 

2. Click on the down arrow to the right of the font name list box. A drop-down list of 

available fonts will appear. 

3. Click on the font of your choice. The selection list will close and the new font will be 

applied to the selected cells.Your font selections might vary from the ones shown here. 

 
 

Selecting a Font Size 

The default font size  in an Excel spreadsheet is 10 points.There are approximately 72 points 

in an inch, so a 10-point font is slightly less than one-seventh of an inch tall. 
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1. Select some cells to change the font size. The cells will be highlighted. 

2. Click on the down arrow to the right of the font size list box. A drop-down list of available 

font sizes will appear 

3. Click on the font size of your choice. The selection list will close and the new font size will 

be applied to the selected cells. 

 

Selecting a Font Style 

Font styles include attributes like bold, italics, and underlining. 
 

1. Select some cells to change the style. The cells will be highlighted. 

2. Click on any of the following options; the attributes will be applied to the text in the cell. 

• Bold button 

• Italics button 

• Underline button 
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The Bold, Italics, and Underline buttons are like toggle switches. Click on them a second  time 

to turn off the attribute. 

 

Adding Cell Borders 

You can add borders or lines to cells to emphasize important data. Borders are different from 

the gridlines that separate cells in the sheet. You can change the style and color of borders.  

*. Select the cells you want to have borders or lines. The cells will be highlighted. 
*. Click on the down arrow next to the Borders button. A selection of border styles will 

display. 

*. Choose a border line style. The selected cells will display the border. 

 

Changing the Spreadsheet Display: 
Excel includes several options to modify the display of your spreadsheet. Most display options 

do not affect how the spreadsheet prints, only the way you see it on the monitor. 

Freezing Spreadsheet Titles: 

You can freeze columns, rows, or both so that column and row titles remain in view as you 

scroll through the sheet. This is particularly helpful with larger spreadsheets. 

1. Click on the desired cell: 

• To freeze columns, position the mouse pointer one cell to the right of the columns you want to 

freeze. 

• To freeze rows, position the cell pointer one cell below the rows you want to freeze. 
• To freeze both columns and rows, position the cell pointer in the cell below the rows and to 

the right of the columns you want to freeze. 

2. Click on Window. The Window menu will appear. 

3. Click on Freeze Panes. Lines will appear on the document indicating the frozen areas. 

 

Using Zoom 

Zoom enlarges or shrinks the display of your spreadsheet to allow you to see more or less of it. 

Zooming in or out does not affect printing. The normal display of your spreadsheet is 100%. 

 

1. Click on the down arrow to the right of the Zoom button. A list of choices will display. 
2. Click on a magnification (%) choice. The higher the number, the larger the cells will appear 

on-screen, and the less of the overall spreadsheet you’ll be able to see. The display of your 

screen will adjust according to your selection. 
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Viewing Formulas : 

When you create formulas, the result of the formula is displayed in the spreadsheet, not the 

formula itself. Having the formula displayed is a wonderful tool for troubleshooting formula 

errors in your spreadsheet. 
 

Click on Tools. The Tools menu will appear. Then Click on Options. The Options dialog box 

will open , Click on the View tab. The View tab will come to the front. Click on Formulas. A 

check mark will display in the option. Click on OK. The dialog box will close. 

 

Completing Your Spreadsheet : 
Preparing to Print: 

Before you print your spreadsheet, you might want to tell Excel what size paper you’d like to 

use, how large the margins should be, and whether to print the gridlines or not. These options 

and others are selected from the Page Setup feature of Excel. 

 

Setting Up Margins 

 

By default, the top and bottom margins are set at 1 inch and the left and right margins are set 

at .75 inch. You can change these margins. 

1. Click on File. The File menu will appear. 

2. Click on Page Setup. The Page Setup dialog box will open. 

3. Click on the Margins tab. The Margins tab will come to the front. 

4. Click on the up/down arrows on each margin that you want to change. A sample is 

displayed in the sample box. 



70 
 

 
 

Setting Page Orientation and Size : 

If your spreadsheet uses quite a few columns, you might want to change the 

orientation or paper size. The default size is 81⁄2 by 11 inch paper in portrait orientation the 

short side at the top. Changing to landscape orientation will print with the long edge of the 

paper at the top. 

 
1. From the Page Setup dialog box, click on the Page tab. The Page tab will come to the front. 

2. Click on an Orientation. The option will be selected. 
3. Click on the down arrow at the right of the Paper Size list box. The list of available paper 

size options will appear. 

4.Click on a paper size. The paper size will be selected. 

Setting Other Printing Options : 

You might want to consider other options for your worksheet, such as whether to print the 

gridlines or the row and column headings. 
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1. From the Page Setup dialog box, click on the Sheet tab. The Sheet tab will come to the 

front. 

2. Click on Gridlines if you want to print the gridlines. A check mark will appear in the 

selection box. 

3. Click on Row and column headings if you want the column headings or row headings to 

print on the spreadsheet. A check mark will appear in the selection box. 

4. Click on OK. The Page Setup dialog box will close. 
 

Printing a Spreadsheet : 
After you have created your spreadsheet, you can print a hard copy to send to someone else  or 

have one for your records. 

Using Print Preview: 

Print Preview allows you to check the overall spreadsheet onscreen prior to printing. 
 

1. Click on the Print Preview button. The document will be sized so that an entire page is 

visible on the screen. 

Don’t strain your eyes trying to read the text in the Preview windows. You are looking at the 

overall perspective here, not necessarily the individual cells. The document is not editable on 

this screen. 

2. Position the mouse pointer over the document. The mouse pointer will turn into a 

magnifying glass. 

3. Click on the document. The text will become larger onscreen. 

4. Click on the document again. The text will become smaller on-screen. 

5. Click on Close. The spreadsheet will be returned to the normal view. 

 

Printing Your Work: 

Typically, the end result of entering a document into Excel is to get text onto paper. 

Excel gives you a quick and easy way to get that result. 

 . Click on the Print button. The spreadsheet will print with standard options. 

   Click on Print. The Print dialog box will open. 
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Printer name. If you are connected to more than one printer, you can choose the name of the 

printer to use for this print job. Click on the down arrow at the right of the Name list box and 

make a selection. 

• Print range. Choose which pages of your document to print with the Print range option boxes. 

• Number of copies. Choose the number of copies to be printed by clicking on the up/down 

arrows in the Number of copies list box. 
 

 Click on any desired option. The option will be activated.

 Click on OK after you have made your selections. The document will be sent to the 

printer. You can also click on the Preview button at this point to review the  document.

 

E-mailing a Spreadsheet : 

 

If you have e-mail access, you can send a document directly to another person. Excel 

copies the content of the spreadsheet into a blank e-mail message. 

1. Click on the e-mail button. The e-mail header box will open. 

2. Type the recipient’s e-mail address. The e-mail address will appear in the To box. 

3. Click in the Subject box and type a subject. If you are using a previously saved document, 
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Excel will automatically insert the document name as the subject of the e-mail. 

4. Click on Send this Sheet. The spreadsheet text is sent to the recipient in the form of an email 

message. 

 

Creating Charts: 
Creating a chart is a simple process using the Excel Chart Wizard. You first decide what you 

want data to chart and how you want it to look. 

 
1. Select the range that you want to chart. The range will be highlighted. 

2. Click on the Chart Wizard button. Step 1 of the Chart wizard will display on-screen. 

3. Click on a Chart type. A selection of chart subtypes will be displayed. 

4. Click on a Chart subtype. The option will be selected. 

5. Click on Next. Step 2 of the Chart Wizard will display. 

6. Click on Rows or Columns to display the data series in rows or columns. The option will be 

selected. 

7. Click on Next. Step 3 of the Chart Wizard will display. 

8. Click in the Chart Title text box. A blinking insertion point will appear. 

9. Type a title for your chart. The title will appear in the chart preview. 

10. Click on Next. Step 4 of the Chart Wizard will display. 

11. Click on a Place Chart option button. The option will be selected. 
12. Click on Finish. The Wizard will close. The chart will be displayed either as a new sheet or 

below the existing data. 

 

Modifying a Chart 
Creating a chart is so simple that it probably will make you want to enhance the chart to 

improve its appearance. Items you can change include the size, style, color, and placement. 

Resizing a Chart 

When a chart is inserted on the spreadsheet page, it will probably be too small to read the  data 

correctly. You can use your mouse to resize it. 

1. If necessary, click on the chart to select it. The chart will have eight small 

handles around it. 

2. Position the mouse pointer over one of the handles. The mouse pointer will change to a 

double-headed arrow. 

 

3. Press the mouse button and drag the black handle. A dotted line will indicate the new 



74 
 

chart size. 

4. Release the mouse button. The chart will be resized. 

 

Moving a Chart 

When a chart is inserted on the spreadsheet page, you can easily move it to any location on  

the page. 

 

1. If necessary, click on the chart to select it. The chart will have eight small handles around it. 

2. Position the mouse pointer anywhere over a blank area of the chart. The mouse pointer will 

be a left-pointing, white arrow. 

3. Press the mouse button and drag the chart to the new location. The mouse will turn into a 

four-headed arrow and a dotted line box will indicate the new position. 

4. Release the mouse button The chart will be moved. 

 

Changing a Chart Style: 

If you want to change the style of the chart, you can select a bar, area, pie, line, or a number of 

other style charts. Most of these charts can also be 3-D. 

1. If necessary, click on the chart. The chart will be selected. 
2. Click on the down arrow to the right of the Chart Type button on the Chart Toolbar. A list of 

chart types will display. 

3. Click on a chart type. The chart will change to the selected type. 

 

Changing the Series Appearance : 

If you do not like the default colors assigned to a chart, you can change them for any series. 
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o Double-click on any colored bar, line, or series item. A small black square will 
appear in all items in the selected series and the Format Data Series dialogbox 
will open. 

o If necessary, click on Patterns. The Patterns tab will come to the front. 

o Click on a color for the selected series. The color will be highlighted. 

o Click on Fill Effects. The Fill Effects dialog box will open. 
o Click on the Gradient, Texture, or Pattern tabs. The tab will come to the front 

with its available options. 

o Click on any desired gradient, texture, or pattern options for the selected series. 

o The pattern will be highlighted. 

o Click on OK. The Fill Effects dialog box will close. 
o Click on OK. The Format Data Series dialog box will close and the series will 

change to the selected options. 

o Repeat the previous steps for each series to be modified. 

 

Modifying Chart Text 

 

You can modify any text font, size, color, or border by double clicking on the text.  

1. Double-click on the text to be modified. The Format dialog box for that section will 

open. 

2. Click on the Font tab. The Font tab will come to the front. 

3. Click on any desired font changes. The options will be selected. 

4. Click on OK. The dialog box will close and the font changes will take affect. 
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Deleting a Chart : 

Deleting a Chart on a Data Sheet 

If the chart is on the same sheet as the data, you’ll delete it with the Delete key. 

1. Click on the chart. The chart will be selected. 

2. Press the Delete key. The chart will be deleted. 

 

Deleting a Chart on Its Own Sheet 

If the chart is on a separate sheet, you’ll need to delete the entire sheet to delete the chart.  

1. Right-click on the sheet tab. This tab is usually marked Chart1, Chart2, and so forth. A 

shortcut menu will appear. 

2. Click on Delete. A confirmation message will appear. 

3. Click on Delete. The chart sheet will be deleted. 
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UNIT – V 

MS-PowerPoint: 

Creating and Viewing Presentations: 
We can use PowerPoint to enhance the presentations. Each PowerPoint presentation file 

consists of slides that contain information that you want to convey to an audience. Think of 

PowerPoint slides as pages of your presentation. 

 

Creating a Presentation PowerPoint creates each presentation file based on a template. A 

template contains predefined information, such as text and colors. 

1. Start PowerPoint.PowerPoint will launch with a blank presentation on the screen. The New 

Presentation Task Pane will appear on the right side on the screen. 

2. Click on From Design Template. The Slide Design task pane will appear. 

 

3. Click on Browse. The Apply Design Template dialog box will open. 

4. Double-click on Presentation Designs. A selection of design templates will appear. 

 

5. Click on a template on which to base your presentation. You will see a preview of the 

template on the right side of the dialog box. Choose a template that most closely represents the 

concept you’re trying to communicate. 

6. Click on Apply. PowerPoint will display the first slide of your new presentation in tri-pane 

view. 
 

 

Adding Text to a Slide 
All new slides contain instruction blocks or placeholders to help you organize your 

presentation. The text that appears on a slide is handled differently than with a standard word 

processor such as Word. Text is stored in objects called text blocks. 
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 Click on a text place holder. The blinking insertion point will appear.

 Type the desired text. The “Click to add” text will be replaced with your text.

 Click on the gray area onscreen. The insertion point and the handles that surrounded the 

text object box will disappear

Adding Slides 

Each page in your presentation is called a slide and all the slides are saved in a 

single file. You can have as many slides in your presentation as you need and you can 

add a slide to a presentation at any time. 

1. Click on the New Slide button. A new slide is added to your presentation. 

 
 

Adding Bullet Point Text 

Bullet point slides also have a place for the slide title, but in the bottom of the slide, a 

text placeholder exists to add strategic bullet point text. You add bulleted text in a similar 

manner as a title. 

 Click on Click to add text. Those words will disappear and will be replaced by a text 

object

 box containing an insertion point.

 Type some text. The text will appear on the line with a bullet point in front.

 Press the Enter key. PowerPoint will start a new line preceded by a bullet.

 Type more text. The text will appear on the screen.

 Press the Enter key. An additional bullet will appear.

 Type text for each bullet you need until you finish typing the last bullet.

 Click on the gray area onscreen. The insertion point and the handles that surrounded the

 text object box will disappear and you will see the bullets you typed on-screen.

 

Switching Views 
You can display your presentation in one of several views in PowerPoint. 

Using Normal Tri-Pane View 

Normal view is really a combination of several views. With Normal view you can see 

your individual slides as well as speaker notes and an overall slide view all at the same 

time. 

 

Viewing Slides 

The Slide pane shows you a close-up image of your slide the way it will appear when 

you print it. 

1. Click on the Slide you want to view. The selected slide will appear. 

The status bar tells you the number of slides in your presentation and which slide 

you are viewing. 

 

Using Slide Sorter View 

Use Slide Sorter view to see a miniature view of each slide in the presentation. Slide 

Sorter view provides an easy way to view the overall effects of your presentation and 

check for variety in slide appearance variety helps keep your audience awake. You can’t 

edit slides in Slide Sorter view, but you can change the order in which the slides appear.  

1. Click on View. The View menu will appear. 

2. Click on Slide Sorter. You will see all the slides in your presentation. A dark border 

will appear around the selected slide. 
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3. Click on a slide. PowerPoint will select the slide, and a black border will appear 

around the slide. 

 

 

Adding and Viewing Speaker Notes : 

You can create speaker notes notes to remind yourself of what you want to say when  

a slide appears. 
 

 

1. In Normal view, display the slide to have a note attached. The slide will display in the 

Slide pane. 

2. Click in the Notes pane. The blinking insertion point will appear. 

3. Type the text that you want to store as a note for the selected slide. The text will display in 

the Notes pane. 

4. Click on the slide. PowerPoint will accept the changes to the notes box. 

 

Viewing a Slide Show : 

 Click on the first slide of the presentation. The first slide will display.
 Click on View. The View menu will appear.
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 Click on Slide Show. All screen elements will disappear, and the image of the first 

slide will fill your screen.

 Click the mouse button or press the right arrow key. The slide show will advance to 

the next slide.

 Continue clicking the mouse button or pressing the right arrow key. Each subsequent 

slide will display.

 At the end of the slide show a final slide message will display.

 Click the mouse anywhere on the screen. The previous view will reappear.

 
 

Editing a Presentation: 
Deleting and Rearranging Slides: 

 

Deleting Slides 

Deleting unwanted slides is only a keystroke away 

1. Click on the slide you want to delete. The slide will be selected. 

2. Press the Delete key. The slide will be deleted. All remaining slides will be pulled up 

to the previous position. 

 
Rearranging Slides 

You might decide that you’d rather display slides in an order other than the one you 

originally created. 

 

1. Click on the slide you want to move. The slide will be selected. 

2. Drag the selected slide to its new location. As you drag, the mouse pointer will change 

to an arrow with a box at the bottom of it. 

You will see a horizontal gray line as you drag. This bar represents the location where 

the new slide will appear when you drop the slide. 

3. Release the mouse button. The slide will appear in its new position. 

 

Editing Text 

You might want to change text that appears on slides. You can edit the text that appears 

on your slides in a variety of ways. Editing text is easiest from the Normal view. 

 Click on the slide that contains text to be changed. The slide will display.
Click on the text you want to modify. The text will display in a text object box 

and a blinking insertion point will appear where you clicked. 

 

 Optionally, select any unwanted text. Click and drag the mouse pointer across the

 text you want to modify. The selected text will be highlighted.

 Type the new text. The new text will appear in the text  object box.

 Click on the gray area onscreen.Your text changes willbe accepted.

 
 

Changing Text Font 

You might want to change the font type or size of your slide’s text. 
1. Display the slide you want to change. The slide will be in the Slide pane. 

2. Select the text you want to change. The text will be highlighted. 
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3. Click on the down arrow next to the Font list box. A list of available fonts will appear. 

4. Click on the font that you want to use. The selected text will reflect the new font. 

 

Deleting a Text Object 

You might find that you need to delete a text object on a slide without deleting 

the slide. 

1. Click on the text object that you want to delete. The selected object will have eight 

small handles surrounding it and the border will have a striped appearance to it. 

As the mouse pointer passes over the border, you will see a four-headed arrow. 

2. If necessary, click on the border of the text object. The border will change from stripes 

to dots. 

3. Press the Delete key. Any existing text and the text object will disappear. 

 

Moving a Text Object 

If you have a text object that’s not in the position you want, you can use your 

mouse to move it to a new position on the slide. 

 Click on the text object that you want to move. The selected object will have eight small 

handles surrounding it and the border will have a striped or dotted appearance

 to it.

 If necessary, click on the border of the text object. The border will change from stripes to 

dots.

 Drag the border to a new position. An outline box will indicate the new position.

 Release the mouse button. The entire text object will move

 

Resizing a Text Object 

Any text object can be resized to make it larger or smaller. 
1. Click on the text object that you want to resize. The selected object will have eight 

small handles surrounding it and the border will have a striped or dotted appearance to it.  

2. If necessary, click on the border of the text object. The border will change from stripes 

to dots. 

3. Position the mouse over one of the white handle boxes surrounding the text object. The 

mouse pointer will turn into a double-headed black arrow. 

4. Click and drag the handle. The new outline of the text object will appear. 

5. Release the mouse button.The text object will be resized. 

Changing Presentation Designs 

If you don’t really like the background appearance of your presentation, you don’t                

need to start over; you can simply change the presentation design. 

o Click on Format. The Format menu will appear. 
o Click on Slide Design. The Slide Design task pane will open and display available 

designs. 
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o Click on a design. The design you selected will be applied to the current presentation. 
 

Changing Slide Layouts 

You might find that you need to change the layout of a slide. For example, you might 

need to change a bullet layout to a table layout or a double column layout. The layout can be 

modified from either Normal or Slide Sorter view. 

 

 Click on the slide with the layout you want to change. The slide will be selected.

 Click on Format. The Format menu will appear.

 Click on Slide Layout. The Slide Layout task pane will open.

 Click on a layout. The layout will be selected and an arrow will appear on the right 

side of

 the selected layout.

 Click on the arrow. A menu will appear.

 Click on Apply Layout. The layout of the selected slide will change to the layout you 

chose.

 
 

Printing a Presentation 
           Print your presentation on paper or on overhead transparencies. The steps you follow 

to print are the same, regardless of the medium to which you choose to print; just place the 

correct medium in your printer. 

1. Click on File. The File menu will appear. 

2. Click on Print. The Print dialog box will open. Included among the items you 

can specify from the Print dialog box are: 

• A printer 

• A specific slide to print 

• The number of copies to print 

• Whether to print in color or black and white. 

 Click on the down arrow next to the Print What list box. A list of choices will appear, 

including slides, handouts, notes pages, and outline view.

 Click on a selection. The selection will appear in the list box.

 Click on OK. The slide features you chose will print.

 

Working with Presentation Special Effects : 
Adding Tables: 

When add a table to a slide in PowerPoint, you actually insert a Microsoft Word table. 

Creating the slide with a table layout is the easiest method. 

o Display the slide to which you will add a table. The slide will be displayed. 

o Double-click on the button in the center of the slide. The Insert Table dialog box will 

o open, suggesting a table of two columns and two rows. 
o Click on the up or down arrows to increase or decrease the number of columns or 

rows. 

o The new quantity will display in the box. 

o Click on OK. After a few moments, a table will appear on your slide. 

o Type some text in the first column. The text will display in the first table cell. 

o Press the Tab key. The blinking insertion point will move to the next cell. 

o Type some text in the second column. The text will display in the second table cell. 

o Press the Tab key. The insertion point will move to the next cell. 
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o Type some text for the rest of the cells in the table, pressing the Tab key to move from 
cell to cell. The text will display in the table cells. 

o When  you  are done,  click  on  the  gray area  outside  the  slide.  The  table will be 
deselected. 

 

Inserting Charts 

. 
We can add a slide that contains a chart created by PowerPoint. 

Display the slide to contain the chart. A button in the middle of the slide will display 

telling you how to add a chart. Double-click on the button. A sample chart and a datasheet 

window will display containing the data used in the sample chart. Change the text and values in 

the cells of the datasheet as needed. Your text and values will display. 

 

Click on the column letter or row number you want to delete. The entire column or row 

will be highlighted. Press the Delete key. All the data in the column will disappear, and the 

chart will adjust itself to display only the data in the remaining columns. Click on the  gray 

area outside the slide. The changes to the chart will be accepted. 

The datasheet window will close. 

 

Inserting an Excel Chart : 

Start Excel and open the worksheet containing the chart that you want to place in 

PowerPoint. The chart will display on the screen. Click on the chart. The chart will be selected. 

Open or switch to your PowerPoint presentation. Your presentation will display. 

Display the slide to contain a chart by clicking it. 

The slide will display on the screen. Click on the Paste button. A copy of the Excel 

chart will appear with handles, indicating it is selected. Position the mouse over one of the 

handles. The mouse pointer will turn into a doubleheaded arrow. Drag a chart handle outward. 

The mouse pointer will change to a cross and a dottedline will indicate the new chart size. 

Release the mouse button. The chart will be resized. 

 

Moving a Chart 

We can also move the chart to a different position on the page. 

 
1. Move the mouse pointer over the chart edge. The mouse pointer will change to a fourheaded 

arrow. 

2. Drag the chart to a different location on the slide. A dotted box indicates the new position. 

3. Release the mouse button. The chart will be moved. 

4. Click anywhere on the gray area. PowerPoint will cancel the selection. 
 

Working with Clip Art : 

You can add visual interest to your slides by using clip art. 
1. Click on the slide to which you want to add clip art. The slide will be displayed. 

Double-click on the button with the words “Double click to add clip art”. The Select Picture 

dialog box will open. Click on the graphic that you want to use. The graphic image will be 

selected Click on OK. The clip art will be inserted onto your slide. Click on the gray area 

outside the slide. PowerPoint will cancel the selection of the image. 

 

Adding Transitions 
Transitions are special effects you can use when you’re creating a presentation you 

intend to show as a slide show on a computer. Transitions make the change between slides 

appear smoother by fading, wiping, or dissolving slides. 
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The View menu will appear. Click on Slide Sorter. PowerPoint will switch to 

Slide Sorter view Click on Edit. The Edit menu will appear. Click on Select All. Click on 

Slide Show. The Slide Show menu will appear Click on Slide Transition. The Slide 

Transition Click on an effect. The slide sorter view will demonstrate the selected effect. Click 

on the Speed arrow. A list of available transition speeds will appear. Click on a speed (Slow, 

Medium, or Fast). 

The slide sorter view will demonstrate the selected effect speed. Click on the drop- 

down arrow at the right of Sound. A list of available sounds will display. Click on a sound. 

Test all your special effects by displaying a slide show. Click on View. The View menu will 

appear. Click on Slide Show. The slide show will display. 
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